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Johdanto 1

Luvun sisällys
• Yleistiedot: sivu 1

• Tuotetuki: sivu 3

• Tuetut laitteet: sivu 3 

• Oppaan käyttäminen: sivu 5

• Käyttöturvallisuus: sivu 6

Yleistiedot   

Kiitos valinnastasi tehdä yhteistyötä Medtronic Diabeteksen kanssa 

parantaaksesi potilaittesi diabeteksen hoidon hallintaa. Uskomme, 

että CareLink™ Pro -ohjelmiston huipputekniikasta ja helppokäyt-
töisestä valikkopohjaisesta käyttöliittymästä on sinulle hyötyä.

Tässä käyttöoppaassa kuvataan, miten voit käyttää CareLink Pro 

-ohjelmistoa potilaan hoito- ja diagnosointitietojen hankintaan, 

tallennukseen ja raportointiin. Käyttöoppaassa kuvataan myös, miten 

voit käyttää pumpun, verensokerimittarin ja glukoosisensorin tietoja, 

jotka potilaat ovat ladanneet CareLink™ Personal -järjestelmään. Se 

on valinnainen www-pohjainen hoidonhallintajärjestelmä, joka toimii 

CareLink Pro -ohjelmiston kanssa.
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Toiminnot 

CareLink Pro on diabeteksen hoidossa käytettävä hoidonhallinta-

ohjelmisto PC-tietokoneelle. Se sisältää muun muassa seuraavat 

toiminnot:

• Potilaan laitteesta ja CareLink Personal -tilistä haetut hoitotiedot 

voidaan tallentaa potilastietueisiin. 

• Insuliinipumppujen, monitorien ja verensokerimittareiden tiedot 

voidaan lähettää ja tallentaa järjestelmään, ja niistä voidaan luoda 

raportteja.

• Ohjelmistoa voidaan käyttää valinnaisen CareLink Personal 

-järjestelmän kanssa, jolloin saat käyttöösi potilaiden omaan tiliinsä 

tallentamat tiedot. Näin voit luoda ajantasaisia raportteja 

vastaanottokäyntien välillä eikä laitetietoja tarvitse välttämättä 

lukea vastaanottokäynnin aikana. 

• Potilastietueeseen tallennetuista laitetiedoista voidaan luoda 

erilaisia hoitoraportteja. Raporttien avulla voit selvittää potilaan 

hoitoon liittyviä asioita, kuten omahoidon onnistumisen ja verensoke-

riarvojen vaihtelumallit ja poikkeamat.

• Järjestelmä ilmoittaa, kun ohjelmistopäivityksiä on ladattavissa ja 

asennettavissa. Näin saat käyttöösi uusimmat toiminnot. 

• CareLink Pro -ohjelmistossa on uusille käyttäjille tarkoitettu 

Guide Me -toiminto. Se antaa ohjeita ja vinkkejä parhaillaan 

suoritettavista toiminnoista.

• Ohjelmiston kaikissa osissa on käytettävissä kiinteä käytönaikainen 

ohje, joka sisältää tietoja eri aiheista.

Tietoturva 

• CareLink Pro voidaan suojata salasanalla.

• CareLink Personal -ohjelmistosta siirrettävät potilastiedot salataan 

teollisuusstandardin mukaisella Secure Sockets Layer (SSL) -proto-

kollalla.

Käyttöoppaaseen liittyvä dokumentaatio     

Seuraavat Medtronic MiniMedin oppaat sisältävät laitekohtaisia 

tietoja, joita ei käsitellä tarkasti tässä käyttöoppaassa. 

HUOMAUTUS: Katso
muiden valmistajien

mittareiden käyttöoh-
jeet mittareiden

mukana toimitetuista
oppaista.

• Paradigm-insuliinipumpun käyttöopas

• Guardian REAL-Time -monitorin käyttöopas

• Sensorin toiminnot

• ComLink-käyttöopas

• CareLink-USB-laitteen käyttöopas.
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Tuotetuki          

Jos tarvitset apua järjestelmän käytössä, ota yhteys oman maasi 

paikalliseen edustajaan. Kansainväliset yhteystiedot ovat seuraavassa 

URL-osoitteessa:

http://www.medtronicdiabetes.com/help/contact/locations.html 

HUOMAUTUS: Joitakin
ohjelmiston tukemia
laitteita ei ehkä ole

saatavilla kaikissa
maissa, joissa
ohjelmisto on

hyväksytty käyttöön.

Tuetut laitteet    

CareLink Pro -ohjelmisto pystyy vastaanottamaan tiedot seuraavista 

laitteista.           

Insuliinipumput/glukoosimonitorit 

Medtronic MiniMed -pumput 508

Medtronic MiniMed Paradigm -sarjan 
pumput 

511, 512, 712, 515, 715, 522, 722, 
522K, 722K, Paradigm® REAL-Time 
Revel™ (523, 723, 523K, 723K),  
Paradigm® Veo™ (554, 754)  

Guardian REAL-Time -monitori CSS-7100
CSS-7100K

Valmistaja Verensokerimittarit     

Medtronic Diabetes 
-yhteistyökumppanien 
laitteet:

• Bayer CONTOUR® LINK

• LifeScan OneTouch® UltraLink™

• BD Paradigm Link® -verensokerimittari

LifeScan:

• OneTouch® UltraSmart®

• OneTouch® Profile®

• OneTouch® Ultra®

• OneTouch® Basic®

• OneTouch® FastTake®

• OneTouch® SureStep®

• OneTouch® Ultra® 2

• OneTouch® UltraMini™

• OneTouch® UltraEasy®

Bayer:

• BREEZE™

• BREEZE™ 2

• CONTOUR®
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BD: • Logic®

Bayer Ascensia® DEX® -sarja, 
mukaan lukien nämä 
yhteensopivat mittarit:

• Ascensia® DEX®

• Ascensia® DEX® 2 

• Ascensia® DEXTER-Z® II

• Glucometer® DEXTER-Z®

• Ascensia® ESPRIT® 2 

• Glucometer® ESPRIT®

• Glucometer® ESPRIT® 2

Bayer Ascensia ELITE™ -sarja, 
mukaan lukien nämä 
yhteensopivat mittarit:

• Ascensia ELITE™

• Glucometer ELITE® XL 

Abbott

• Precision Xtra™ 

• TheraSense FreeStyle®, FreeStyle Flash™
• FreeStyle Papillion™ Mini 
• FreeStyle Mini
• Optium Xceed™
• Precision Xceed™

Roche

• Accu-Chek® Aviva

• Accu-Chek® CompactPlus

• Accu-Chek® Compact

• Accu-Chek® Active

Tiedonsiirtolaitteet                 

 Com-Station

Tarkoitettu käytettäväksi 
MiniMed 508 -pumpun kanssa. (Katso 
Com-Station-käyttöoppaasta lisätiedot 
laitteistovaatimuksista.)

ComLink

Tarkoitettu käytettäväksi 
MiniMed Paradigm -pumpun ja 
Guardian REAL-Time -monitorin kanssa. 
(Katso ComLink-käyttöoppaasta lisätiedot 
laitteistovaatimuksista.) 

Paradigm Link® -verensokerimittari

Tarkoitettu käytettäväksi 
MiniMed Paradigm -pumpun ja 
Guardian REAL-Time -monitorin kanssa. 
(Katso Paradigm Link® -verensokeri-
mittarin käyttöoppaasta lisätiedot 
laitteistovaatimuksista.)

CareLink™-USB-laite
Tarkoitettu käytettäväksi 
MiniMed Paradigm -pumpun ja 
Guardian REAL-Time -monitorin kanssa.

Tiedonsiirtokaapeli

Tarkoitettu käytettäväksi kolmansien 
osapuolien verensokerimittareiden 
kanssa. Mittarin valmistajat toimittavat 
tiedonsiirtokaapelin mittarin mukana.

Valmistaja Verensokerimittarit     
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Vastaavat laitteet       

Kun lisäät järjestelmään laitteen, sinun on valittava sen merkki ja 

malli luettelosta. Jos laitteen merkki ja malli eivät ole luettelossa, 

käytä seuraavassa taulukossa lueteltuja vastaavia laitteita.

HUOMAUTUS: Mittarit
voidaan tilata niiden

valmistajilta.

Tilaaminen                       

Tilaa Medtronic Diabetes -tuotteita oman maasi paikalliselta 

edustajalta. Medtronicin kansainväliset yhteystiedot ovat seuraavassa 

URL-osoitteessa:

http://www.medtronicdiabetes.com/help/contact/locations.html

Oppaan käyttäminen   

Sanasto sisältää termien ja toimintojen määritelmiä. Seuraavassa 

taulukossa on selitetty oppaassa käytetyt merkinnät.

Käyttöopas sisältää esimerkkejä ohjelmiston näytöistä. Ohjelmiston 

näytöt voivat olla todellisuudessa hiukan erilaisia.

Potilaan käyttämä laite Valittava laite

• Bayer Ascensia® DEX®

• Bayer Ascensia® DEX® 2

• Bayer Ascensia® DEXTER-Z® II

• Bayer Glucometer® DEXTER-Z®

• Bayer Ascensia® ESPRIT® 2 

• Bayer Glucometer® ESPRIT®

• Bayer Glucometer® ESPRIT® 2

Bayer Ascensia® DEX®

Bayer Glucometer ELITE® XL Bayer Ascensia ELITE™ XL 

Precision Xceed™ Optium Xceed™

Termi/tyyli Merkitys

Napsauta Valitse näytön kohde painamalla hiiren ykköspainiketta 
kohteen kohdalla. 

Kaksoisnapsauta Avaa näytön kohde painamalla hiiren ykköspainiketta 
kaksi kertaa kohteen kohdalla.

Napsauta hiiren 
kakkospainikkeella

Avaa toinen ikkuna tai valikko painamalla hiiren 
kakkospainiketta näytön kohteen kohdalla.

Lihavoitu teksti Valikkovaihtoehto tai valikkopolku. Esimerkki: Patient
> New Patient
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Käyttöturvallisuus         

Käyttöaiheet 

CareLink Pro -järjestelmä on tarkoitettu diabeteksen hoidon hallinnan 

apuvälineeksi. Järjestelmän tarkoitus on vastaanottaa tietoja 

insuliinipumpuista, verensokerimittareista ja jatkuvatoimisista 

glukoosimonitorointijärjestelmistä ja muuntaa tiedot CareLink Pro 

-raporteiksi. Raportit sisältävät tietoja, joiden avulla voidaan 

tunnistaa trendejä ja seurata potilaan päivittäisiä toimia, kuten 

nautittua hiilihydraattimäärää, ateria-aikoja, insuliinin annostelua ja 

glukoosiarvoja. 

Vaarat 

• Järjestelmä on tarkoitettu diabeteksen hoitoon perehtyneiden 

terveydenhoidon ammattilaisten käyttöön. 

• Järjestelmän tulosten tarkoitus ei ole antaa lääketieteellisiä 

toimintaohjeita, eikä niitä saa käyttää sellaiseen tarkoitukseen. 

• Ohjelmistoa saa käyttää vain tässä oppaassa lueteltujen tuettujen 

laitteiden kanssa. (Katso kohta Tuetut laitteet sivulla 3.)

• Potilaita tulee kehottaa mittaamaan verensokeri vähintään 

4–6 kertaa päivässä.

• Potilaille on muistutettava, että he eivät saa muuttaa hoitoaan 

kysymättä ensin neuvoa terveydenhoidon ammattilaiselta.

• Potilaiden tulee tehdä hoitopäätöksiä terveydenhoidon 

ammattilaisten ohjeiden ja mittarin verensokeriarvojen perusteella, 

ei glukoosisensorin tulosten perusteella.

ISOILLA KIRJAIMILLA 
kirjoitettu teksti Painikkeen nimi. Esimerkki: SAVE

Kursivoitu teksti Näyttöjen ja kenttien nimet. Esimerkki: Reports-näyttö

HUOMAUTUS: Lisätietoja

VAROITUS: Varoittaa vaaratilanteesta, joka voi johtaa vähäisiin tai 
melko vakaviin ohjelmisto- tai laitevaurioihin.

VAARA: Varoittaa mahdollisesta vaaratilanteesta, joka voi 
johtaa kuolemaan tai vakaviin vammoihin. Se voi myös 
selittää mahdollisia vakavia haittavaikutuksia ja 
vaaratilanteita.

Termi/tyyli Merkitys
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Vasta-aiheet 

Ohjelmiston kanssa ei saa käyttää laitteita, joita ei ole lueteltu 

kohdassa Tuetut laitteet sivulla 3. Ohjelmistoa ei saa myöskään 

käyttää muiden tilojen kuin diabeteksen hoitoon.

Ennen kuin avaat ohjelmiston, sulje kaikki seuraavat ohjelmistot, jos 

ne ovat käynnissä:

• CGMS® System Solutions™ -ohjelmisto 

• Solutions® Pumps & Meters -ohjelmisto 

• Guardian® Solutions® -ohjelmisto 

• ParadigmPAL™

• CareLink™ Personal 

• CGMS® iPro -järjestelmän Solutions®-ohjelmisto.
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Siirtyminen järjestelmässä 2

Luvun sisällys
• Yleistiedot: sivu 8

• CareLink Pro -ohjelmiston avaaminen: sivu 8

• Työtilat: sivu 10

• Päävalikkorivi: sivu 12

• Työkalurivi: sivu 12

• Guide Me -toiminto: sivu 13

• Learn more -linkit: sivu 14

• Ohjejärjestelmä: sivu 14

Yleistiedot

Tämän luvun avulla voit tutustua CareLink™ Pro -ohjelmiston 

graafiseen käyttöliittymään. Käyttöliittymä sisältää valikoita, 

työkalurivin, siirtymispalkin, työtiloja ja Guide Me -ikkunan. 

CareLink Pro -ohjelmiston avaaminen

1 Kaksoisnapsauta tietokoneen työpöydän CareLink Pro -kuvaketta.

Jos laitos edellyttää salasanan syöttämistä, näkyviin tulee kirjautu-

misnäyttö.

 CareLink Pro
-työpöytäkuvake
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a. Kirjoita salasana Password-kenttään.

HUOMAUTUS: Salasanan
syöttäminen on

valinnainen toiminto,
joka määritetään

asennuksen yhteydessä.

b. Valitse LOGIN.

Näkyviin tulee aloitusnäyttö.

2 Jos haluat luoda uuden potilastietueen, napsauta NEW PATIENT 

-painiketta. Jos haluat avata järjestelmän potilasluettelossa olevan 

potilastietueen, napsauta OPEN PATIENT -painiketta.

        

päävalikot

aktiivinen 
työtila

avaa potilasluettelolisää uusi potilas

siirtymispalkki

tilarivi

Reports-
työtilapainike

Devices-
työtilapainike

Profile-
työtilapainike

näytä/piilota Guide Me 
-ikkuna
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Työtilat     

HUOMAUTUS:
Lisätietoja työtiloista
ja niiden käytöstä on
tämän käyttöoppaan

muissa luvuissa.

Jos potilastietue on avoinna, saat näkyviin haluamasi työtilan 

napsauttamalla siirtymispalkin vastaavaa painiketta. Näissä 

työtiloissa voit syöttää tai valita tietoja potilaalle suoritettavia 

CareLink Pro -tehtäviä varten.

• Profile: Tässä työtilassa voit muokata tallennettuja potilastietoja, 

kuten nimeä ja syntymäaikaa. Tässä työtilassa voit myös muodostaa 

yhteyden potilaan CareLink Personal -tiliin.

• Devices: Tässä työtilassa voit tallentaa tiedot, joita tarvitaan 

potilaan laitetietojen luvussa.

• Reports: Tässä työtilassa voit valita parametrit ja potilaalle luotavat 

raportit.

Ennen kuin olet lisännyt ja tallentanut potilaalle profiilin, ainoa 

potilaalla käytettävissä oleva työtila on Profile. Ennen kuin olet 

lisännyt potilaalle laitteita, ainoat potilaalla käytettävissä olevat 

työtilat ovat Profile ja Devices.
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Työtilat

Devices-työtila

Profile-työtila

Reports-työtila

Profile

Devices

Reports
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Päävalikkorivi       

Seuraavassa kuvassa näkyvät päävalikon vaihtoehdot. Jotkin näistä 

valikkovaihtoehdoista voidaan valita myös pikanäppäimillä, jotka on 

lueteltu valikkovaihtoehdon vieressä (esimerkiksi Ctrl+N vaihtoeh-

dolle New Patient). Voit valita jotkin valikkovaihtoehdot myös 

siirtymispalkin tai työkalurivin avulla.

Työkalurivi     

CareLink Pro -työkalurivin avulla voit valita nopeasti useimmin 

käytettävät toiminnot. Työkalurivi sisältää seuraavat painikkeet.

Painike Nimi Toiminto

Add Patient Avaa Profile-työtilan, jossa voit lisätä 
järjestelmään uuden potilastietueen.

Open Patient
Avaa Patient Lookup -taulukon, jossa voit 
tarkastella haluamaasi olemassa olevaa 
potilastietuetta.

Guide Me
Näyttää tai piilottaa Guide Me -ikkunan. 
Saat näyttöön tilannekohtaiset ohjeet 
painiketta napsauttamalla. 
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Potilasvälilehdet

Kun avaat potilastietueen, näytön työkalurivin alle tulee välilehti, 

jossa lukee potilaan nimi. Kun välilehti on aktiivinen, potilastietue ja 

työtila ovat aktiivisia ja voit suorittaa potilaalle CareLink Pro 

-tehtäviä.

Voit aktivoida haluamasi potilaan potilastietueen napsauttamalla 

potilasvälilehteä. Voit sulkea tietueen napsauttamalla potilas-

välilehden sulkemispainiketta.

Guide Me -toiminto 

Guide Me -toiminto on käytettävissä CareLink Pro -ohjelmiston 

kaikissa osissa. Toiminto avaa tilannekohtaisia ohjeita ja vinkkejä 

sisältävän ikkunan toiminnoista, joita saatat käyttää järjestelmän 

aktiivisessa osassa. Guide Me -ikkunat voivat sisältää myös 

>>learn more -linkkejä. Linkkejä napsauttamalla pääset käytönai-

kaisen ohjeen vastaaviin aiheisiin ja lisätietoihin. Guide Me -toiminto 

on käytössä oletusarvoisesti. Voit kuitenkin poistaa toiminnon 

käytöstä milloin tahansa.

sulkemispainike 

epäaktiivinen välilehti aktiivinen välilehti

Sulkemispainike
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Guide Me -toiminnon ottaminen käyttöön ja poistaminen käytöstä 

Painikevaihtoehto

• Voit ottaa Guide Me -toiminnon käyttöön tai poistaa sen käytöstä 

napsauttamalla GUIDE ME -painiketta.

Valikkovaihtoehto

• Voit ottaa toiminnon käyttöön tai poistaa sen käytöstä valitsemalla 

Help > Guide Me.

Learn more -linkit     

Learn more -linkeistä pääset käytönaikaisen ohjejärjestelmän 

vastaavaan aiheeseen. Linkit ovat käytössä järjestelmän kaikissa 

osissa joko Guide Me -ikkunoissa tai itse ohjelmistossa. Napsauta 

>> learn more -linkkiä, jos et ole varma, miten voit jatkaa tai mitä 

arvoja sinun on syötettävä.

Ohjejärjestelmä     

Ohjejärjestelmä auttaa CareLink Pro -ohjelmiston käytössä ja sisältää 

tietoja ohjelmiston tehtävien suorittamisesta. 

Voit avata ohjejärjestelmän seuraavasti:

• Valitse Help > Medtronic CareLink Pro Help.

• Paina F1-näppäintä.

Guide Me -painike

learn more -linkki
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Käytön aloittaminen 3

Luvun sisällys
• Ennen kuin aloitat: sivu 15

• Potilastietueiden avaaminen ja sulkeminen: sivu 17

• Järjestelmäasetusten määrittäminen: sivu 18 

Tässä luvussa kuvataan CareLink™ Pro -ohjelmiston käynnistä-

minen, potilastietueiden avaaminen ja sulkeminen sekä kaikkia 

järjestelmän potilaita koskevien asetusten määrittäminen. 

Ennen kuin aloitat

Jos käytät CareLink Pro -järjestelmää ensimmäisen kerran, 

määritä ensin yleiset asetukset (katso kohta Yleiset asetukset 

sivulla 18). Nämä asetukset määrittävät tiettyjen tietojen 

esitystavan ohjelmistossa ja raporteissa sekä järjestelmän 

Internet-yhteyttä käyttävät toiminnot.

Asetukset voidaan määrittää milloin tahansa. On ehkä parasta 

tutustua CareLink Pro -ohjelmistoon, ennen kuin määrität muut 

asetukset.
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Järjestelmän tärkeimmät tehtävät   

Seuraavassa taulukossa on kuvattu päätehtävät, jotka on suoritettava 

CareLink Pro -ohjelmiston ensimmäisellä määritys- ja käyttökerralla. 

Taulukossa on myös käyttöoppaan kohta, jossa kukin tehtävä 

kuvataan.

Tehtävä Kohta

Tutustu CareLink Pro -ohjelmiston 
käyttöliittymään. Luku 2, Siirtyminen järjestelmässä

Määritä yleiset järjestelmäasetukset, 
joita laitos käyttää.

Järjestelmäasetusten määrittäminen 
sivulla 18

Luo profiilit kaikille potilaille. Uusien profiilien lisääminen 
sivulla 25

Muodosta yhteys potilaiden CareLink 
Personal -tileihin.

Yhteyden luominen CareLink Personal 
-tiliin (valinnainen) sivulla 26

Lisää pumppu ja mittarit potilaiden 
profiileihin. Laitteen lisääminen sivulla 36

Lue tiedot potilaiden pumpusta ja 
mittareista. Laitetietojen lukeminen sivulla 42

Määritä ja luo raportit kaikille potilaille. Raporttien luominen sivulla 45

Varmuuskopioi CareLink Pro -tietokanta 
säännöllisesti.

Tietokannan varmuuskopioiminen 
sivulla 57

Päivitä CareLink Pro -ohjelmisto.
Ohjelmistopäivitysten asentaminen 
sivulla 56
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Potilastietueiden avaaminen ja sulkeminen

Potilastietueiden avaaminen   

Samanaikaisesti voi olla avoinna enintään kuusi potilastietuetta. Jos 

et ole vielä luonut potilasprofiileja, katso kohta Uusien profiilien 

lisääminen sivulla 25.

1 Valitse File > Open Patient tai napsauta OPEN PATIENT -painiketta. 

Näyttöön tulee seuraavankaltainen potilasluettelo.

HUOMAUTUS: Jos
näyttöön tulee viesti,

jonka mukaan liian
monta potilastietuetta
on avoinna, valitse OK,

sulje yksi tietue ja
jatka.

2 Etsi potilas luettelosta kirjoittamalla potilaan nimi tai osa nimestä 

Find a Patient -kenttään. Kun potilaan rivi on korostettuna 

luettelossa, avaa potilastietue valitsemalla OPEN tai kaksoisnap-

sauttamalla riviä tai painamalla ENTER-näppäintä. Voit myös selata 

luetteloa käyttämällä näppäimistön ylä- ja alanuolinäppäimiä. 

Näyttöön tulee potilaan Devices-työtila (jos potilaalle ei ole vielä 

lisätty laitteita) tai Reports-työtila.

3 Voit avata potilaan Profile-työtilan napsauttamalla siirtymispalkin 

PROFILE-painiketta.

Potilastietueiden sulkeminen  

1 Varmista, että suljettava potilastietue on aktiivinen (välilehti on 

korostettu).

2 Toimi jollakin seuraavista tavoista:

a. Valitse File > Close Patient.

b. Napsauta potilasvälilehden sulkemispainiketta.

c. Paina pikanäppäintä Ctrl+F4.

Open Patient
-painike

Profile-painike

Sulkemispainike
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Järjestelmäasetusten määrittäminen   

Nämä asetukset koskevat järjestelmän kaikkia potilaita. Lisätietoja 

potilaskohtaisista asetuksista on kohdassa Raporttiasetusten 

tarkistaminen sivulla 49.

Asetukset on jaettu seuraaviin ryhmiin:

• General

– Glucose Units

– Carbohydrate Units

– Communications

– Troubleshooting
• Patient Profile

– Valitse ja järjestä potilasprofiilien tietokentät.
• Patient Lookup

– Muokkaa kenttiä ja muuta kenttien esitysjärjestystä sen mukaan, 
miten haluat niiden näkyvän, kun avaat potilasluettelon 
valitsemalla Open Patient.

• Report Generation

– Valitse tietokentät, joiden haluat näkyvän tietotaulukossa, jonka 
perusteella valitaan Daily Detail -raportin sisältö.

Yleiset asetukset

1 Valitse Tools > Options. Näyttöön tulee seuraava ikkuna.
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2 Valitse haluamasi vaihtoehdon valintanappi:

– Glucose Units: mg/dL tai mmol/L

– Carbohydrate Units: grams tai Exchanges

a. Jos valitset Carbohydrate Units -asetukseksi Exchanges, kirjoita 
grams are equal to 1 Exchange -kenttään, kuinka monta 
grammaa vastaa yhtä vaihtoannosta.

3 Voit ottaa käyttöön tai poistaa käytöstä seuraavat Communications-

osion toiminnot valitsemalla valintaruudun tai poistamalla sen 

valinnan:

HUOMAUTUS: Noudata
sairaalan tai IT-osaston

ohjeita, kun määrität
Internet-yhteyttä

käyttävien toimintojen
asetukset.

– Automatically check for software updates: Jos valitset tämän 
vaihtoehdon, kaikkiin tietokoneisiin, joissa CareLink Pro on 
käynnissä, lähetetään ilmoitus saatavilla olevista ohjelmisto-
päivityksistä. Aktiivisella käyttäjällä on tällöin mahdollisuus 
ladata ja asentaa päivitykset. Jos haluat estää tämän ja jakaa 

ohjelmistopäivitykset ohjatusti, poista valintaruudun valinta.

– Synchronize with CareLink™ Personal: Jos haluat synkronoida 
järjestelmän automaattisesti potilaiden CareLink Personal -tilin 
tietojen kanssa aina, kun avaat heidän profiilinsa, valitse 
Synchronize with CareLink Personal -valintaruutu. Jos poistat 
valintaruudun valinnan, sinun on synkronoitava kunkin potilaan 
CareLink Personal -tilin tiedot manuaalisesti.

4 Valitse napsauttamalla Troubleshooting-osion valintaruutu tai poista 

sen valinta. Jos valintaruutu on valittuna, sovellus tallentaa luvun 

yhteydessä laitteen asetukset vianetsintää varten.

5 Tallenna yleiset asetukset valitsemalla OK. 
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Potilasprofiilin asetukset 

1 Valitse Tools > Options.

2 Napsauta Patient Profile -välilehteä. Näyttöön tulee seuraava 

ikkuna.

Tietokenttien valitseminen

1 Lisää haluamasi kentät valitsemalla niiden valintaruudut.

HUOMAUTUS: First
Name- ja Last Name

-kenttää ei voi poistaa.

2 Voit poistaa kentän profiilista poistamalla sen valintaruudun 

valinnan.

3 Voit määrittää kentän pakolliseksi valitsemalla Required-sarakkeen 

valintaruudun. Pakolliset kentät on täytettävä profiilia luotaessa.

Mukautetun kentän lisääminen 

1 Valitse tyhjän mukautetun kentän vasemmalla puolella oleva 

valintaruutu.

2 Kirjoita kentän nimi (esimerkiksi ”Yhteyshenkilö hätätapauksessa”). 

Tämä teksti näkyy kentän nimenä potilasprofiilissa.

3 Voit määrittää kentän pakolliseksi valitsemalla Required-sarakkeen 

valintaruudun.

Valitse profiiliin haluamasi kentät valitsemalla kenttien valintaruudut. Järjestä 
kentät haluamaasi järjestykseen ylä- ja alanuolipainikkeilla.
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HUOMAUTUS: Voit
poistaa mukautetun

kentän profiilista
poistamalla kentän

vieressä olevan
valintaruudun valinnan.

Tietokenttien järjestyksen muuttaminen 

• Valitse siirrettävä kenttä ja siirrä sitä napsauttamalla ylä- tai 

alanuolipainiketta. (Ylin ja alin nuolipainike siirtävät kentän koko 

luettelon alkuun tai loppuun.) 

Potilasprofiilin asetusten hyväksyminen

• Kun Field Order -luettelo sisältää kaikki haluamasi kentät oikeassa 

järjestyksessä, valitse OK.

Potilasprofiilit sisältävät nyt valitsemasi kentät valitsemassasi 

järjestyksessä.

Potilashaun asetukset 

1 Valitse Tools > Options.

2 Napsauta Patient Lookup -välilehteä. Näyttöön tulee seuraava 

ikkuna.

Näkyvien tietojen valitseminen

• Valitse Patient Lookup -taulukossa näkyvät tiedot valitsemalla niiden 

valintaruutu tai poista tiedot poistamalla valintaruutujen valinta.

Ylä- ja alanuoli-
 painikkeet

Valitse Patient Lookup -taulukkoon haluamasi tiedot valitsemalla niiden valintaruudut
Järjestä sarakkeet haluamaasi järjestykseen ylä- ja alanuolipainikkeilla.
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HUOMAUTUS: First
Name- ja Last Name

-kenttää ei voi poistaa.

Sarakkeiden järjestyksen muuttaminen

• Voit muuttaa Patient Lookup -taulukon sarakkeiden järjestystä 

valitsemalla siirrettävän sarakkeen ja napsauttamalla ylä- ja 

alanuolipainikkeita. (Ylin ja alin nuolipainike siirtävät tietosarakkeen 

koko luettelon alkuun tai loppuun.)

HUOMAUTUS: Column
Display Order -luettelon

ylin tietosarake näkyy
Patient Lookup

-taulukon ensimmäisenä
sarakkeena. Alin

tietosarake näkyy
taulukon viimeisenä

sarakkeena.

Potilashaun asetusten hyväksyminen

• Kun Column Display Order -luettelo sisältää kaikki haluamasi tiedot 

oikeassa järjestyksessä, valitse OK.

Patient Lookup -taulukko sisältää nyt valitsemasi tiedot 

valitsemassasi sarakejärjestyksessä.

Raporttien luontiasetukset 

Raporttien luonnin aikana näyttöön tulee tietotaulukko, josta 

valitaan raporteissa näkyvät tiedot. Taulukon tulee sisältää tiedot, 

joiden perusteella terveydenhoidon ammattilainen voi parhaiten 

päättää, miltä vuorokausilta hän haluaa nähdä vuorokausikohtaiset 

tiedot sisältävän Daily Detail -raportin.

HUOMAUTUS: Kohdassa
Raporttityyppien ja

-päivämäärien
valitseminen sivulla 50

on kuvattu, miten nämä
asetukset vaikuttavat

tietotaulukkoon
raporttien luonnin

aikana.

1 Valitse Tools > Options.

2 Napsauta Report Generation -välilehteä. Näyttöön tulee seuraava 

ikkuna.

Ylä- ja alanuoli-
 painikkeet

Valitse tietotaulukkoon haluamasi tiedot valitsemalla niiden valintaruudut. Järjestä 
sarakkeet haluamaasi järjestykseen ylä- ja alanuolipainikkeilla.
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Näkyvien tietojen valitseminen

• Valitse tietotaulukkoon haluamasi tiedot valitsemalla niiden 

valintaruudut tai poista tiedot taulukosta poistamalla valintaruutujen 

valinta.

Sarakkeiden järjestyksen muuttaminen

• Voit muuttaa tietotaulukon sarakkeiden järjestystä valitsemalla 

siirrettävän sarakkeen ja napsauttamalla ylä- ja alanuolipainikkeita. 

(Ylin ja alin nuolipainike siirtävät tietosarakkeen koko luettelon 

alkuun tai loppuun.)

HUOMAUTUS: Column
Order -luettelon

ylimmät tiedot näkyvät
tietotaulukon

ensimmäisessä
sarakkeessa. Alimmat

tiedot näkyvät
tietotaulukon

viimeisessä
sarakkeessa.

Raporttien luontiasetusten hyväksyminen

• Kun Column Order -luettelo sisältää kaikki haluamasi tiedot oikeassa 

järjestyksessä, valitse OK. 

Tietotaulukko sisältää nyt valitsemasi tiedot valitsemassasi 

sarakejärjestyksessä.

Ylä- ja alanuoli-
 painikkeet
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Profile-työtila 4

Luvun sisällys
• Ennen kuin aloitat: sivu 24

• Uusien profiilien lisääminen: sivu 25

• Potilasprofiilien muokkaaminen: sivu 25

• Potilastietojen poistaminen järjestelmästä: sivu 25

• Yhteyden luominen CareLink Personal -tiliin (valinnainen): sivu 26

Profiili muistuttaa potilaskertomuksen kansilehteä. Se sisältää 

potilastiedot, kuten nimen ja syntymäajan. Potilaalle on luotava 

profiili, ennen kuin laitetietoja voidaan kerätä ja käyttää hoitorapor-

teissa.

Profile-työtilassa voit myös muodostaa yhteyden potilaan CareLink 

Personal -tiliin. Kun yhteys on muodostettu, voit hakea potilaan 

laitetiedot CareLink Personal -tilistä milloin tahansa ilman että 

potilaan tarvitsee tulla vastaanotolle.

Ennen kuin aloitat

Voit tarvittaessa mukauttaa potilasprofiilit niin, että ne sisältävät 

vain tiedot, joita haluat kerätä. Lisätietoja on kohdassa 

Potilasprofiilin asetukset sivulla 20.

Lisäksi tarvitset käyttäjänimen ja salasanan, jos haluat muodostaa 

yhteyden potilaan CareLink Personal -tiliin. Potilaan on oltava läsnä, 

kun määrität yhteystiedot.
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Uusien profiilien lisääminen        

Aina kun lisäät potilaan CareLink Pro -järjestelmään, sinun on ensin 

täytettävä potilaalle profiili. 

1 Valitse File > New Patient tai napsauta ADD PATIENT -painiketta. 

Näyttöön tulee Profile-työtila (katso esimerkki sivulla 11). 

HUOMAUTUS: Jos haluat
lisätä tai muuttaa

potilasprofiilin kenttiä,
napsauta

>>customize fields
-linkkiä. Katso kohta

Potilasprofiilin asetukset
sivulla 20.

2 Täytä Patient Profile -osion kentät. 

3 Valitse SAVE.

Uusi potilasprofiili lisätään CareLink Pro -tietokantaan. Näyttöön 

tulee viesti, joka vahvistaa profiilin tallennuksen.

Jos et ole täyttänyt pakollista kenttää, kun tallennat potilasprofiilin, 

kentän viereen tulee viesti. Et voi tallentaa profiilia, ennen kuin 

kenttä on täytetty.

Potilasprofiilien muokkaaminen 

1 Varmista, että potilaan Profile-työtila on avoinna.

2 Valitse EDIT.

3 Muokkaa haluamiasi tietoja Patient Profile -osiossa.

4 Valitse SAVE.

Näyttöön tulee viesti, joka vahvistaa profiilin tallennuksen.

Potilastietojen poistaminen järjestelmästä 

1 Varmista, että potilaan Profile-työtila on avoinna. 

2 Tarkista, että olet poistamassa oikean potilaan. Potilasprofiilin 

poistaminen poistaa myös kaikki potilaan tiedot CareLink Pro 

-tietokannasta, eikä poistoa voi peruuttaa.

3 Napsauta >> delete patient record -linkkiä, joka on profiilin 

synkronointiosion yläpuolella.

Näyttöön tulee viesti, joka varoittaa siitä, että potilastietueen 

poistaminen poistaa kaikki potilastiedot. 

4 Poista potilastietue valitsemalla YES.

Add Patient
-painike
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Yhteyden luominen CareLink Personal -tiliin 
(valinnainen)         

Voit muodostaa yhteyden potilaan CareLink Personal -tiliin, jos 

potilas antaa siihen luvan. Potilaat voivat ladata ja tallentaa 

laitteesta saadut tiedot tähän www-pohjaiseen työkaluun ja luoda 

erilaisia hoitoraportteja. 

Kun olet luonut yhteyden potilaan CareLink Personal -tiliin, voit 

hakea potilaan tallentamat laitetiedot omalle koneellesi CareLink Pro 

-raporttien luontia varten. Raportteja voidaan luoda milloin tahansa, 

myös vastaanottokäyntien välillä. Se myös vähentää tarvetta lukea 

potilaan laitteen tiedot vastaanotolla.

Jos potilaalla ei ole vielä CareLink Personal -tiliä, voit kehottaa häntä 

luomaan tilin lähettämällä sähköpostikutsun. 

Yhteyden luominen olemassa olevaan tiliin

HUOMAUTUS: Potilaan
pitää olla läsnä näiden

vaiheiden aikana.

1 Varmista, että Internet-yhteys on auki.

2 Avaa potilaan Profile-työtila. 

3 Varmista, että kaikki Patient Profile -osion pakolliset kentät on 

täytetty.

4 Valitse LINK TO EXISTING ACCOUNT. 

Näkyviin tulee CareLink Personal Log In -sivu.

5 Anna potilaan tehdä seuraavat toimet:

a. Kirjoita käyttäjänimi ja salasana.

b. Valitse SIGN IN. 
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Näkyviin tulee Grant Access -sivu, joka perustuu potilaan 

ilmoittautumisen yhteydessä antamiin kieli- ja alueasetuksiin.

6 Anna potilaan tehdä seuraavat toimet:

a. Lue käyttöehdot.

b. Hyväksy käyttöehdot valitsemalla I agree to the Terms of Use 
above... -valintaruutu. 

c. Valitse GRANT ACCESS.

d. Pyydä potilasta ilmoittamaan, kun näytössä näkyy Thank You 
-sivu.
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Voit tulostaa käyttöehdot potilaalle napsauttamalla PRINT-painiketta.

Sinulla on nyt yhteys potilaan CareLink Personal -tiliin. Katso kohta 

Tietojen hakeminen yhdistetystä tilistä sivulla 29.

Sähköpostikutsun lähettäminen 

Voit kehottaa potilasta luomaan CareLink Personal -tilin lähettämällä 

hänelle sähköpostikutsun seuraavasti:

1 Avaa potilaan Profile-työtila. 

2 Varmista, että kaikki Patient Profile -osion pakolliset kentät on 

täytetty.

3 Valitse SEND E-MAIL INVITATION TO PATIENT.
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4 Varmista, että Patient Name-, E-Mail Address- ja Language-kentät 

on täytetty oikein.

5 Valitse SEND. 

Potilasprofiilin tila-alueella näkyy vahvistus sähköpostin lähettämi-

sestä.

Potilaan CareLink Personal -tilin ja CareLink Pro -ohjelmiston 
yhteyden poistaminen

Voit poistaa potilaan CareLink Personal -tilin ja CareLink Pro 

-ohjelmiston yhteyden. Tämä vaihtoehto on käytettävissä vain silloin, 

kun potilaan tiliin on luotu yhteys. Kun yhteys poistetaan, CareLink 

Pro -ohjelmisto ei voi enää hakea tietoja potilaan CareLink Personal 

-tilistä. Se ei vaikuta siihen, miten potilas itse käyttää CareLink 

Personal -tiliään.

1 Avaa potilastietue ja avaa Profile-työtila.

2 Valitse UNLINK ACCOUNT.

3 Valitse vahvistusviestistä YES. Potilaan henkilökohtainen profiili ei 

ole enää yhteydessä CareLink Pro -ohjelmistoon.

Tilaksi vaihtuu ”Not linked”, ja näytössä näkyvät LINK TO EXISTING 

ACCOUNT- ja SEND E-MAIL INVITATION TO PATIENT -painikkeet.

Tietojen hakeminen yhdistetystä tilistä            

Jos sinulla on yhteys potilaan CareLink Personal -tiliin, CareLink Pro 

-ohjelmisto hakee tilin mahdolliset uudet tiedot automaattisesti joka 

kerta, kun avaat potilaan potilasprofiilin. 
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HUOMAUTUS: Voit
varmistaa tietojen

automaattisen haun
valitsemalla Tools >
Options > General ja
varmistamalla, että

Synchronize with
Medtronic CareLink

Personal -valintaruutu
on valittuna.

Voit hakea potilaan CareLink Personal -tilin tiedot milloin tahansa 

potilasprofiilin avaamisen jälkeen seuraavasti:

1 Varmista, että potilaan Profile-työtila on avoinna ja että Internet-

yhteys on auki.

2 Valitse Tools > Synchronize Patient Data.

Potilasvälilehden synkronointikuvake pyörii. Kun kuvake pysähtyy, 

tietojen haku on päättynyt.

HUOMAUTUS: Jos
potilas ei enää halua

jakaa CareLink Personal
-tietojaan, hän voi

poistaa tämän
toiminnon käytöstä
OPTIONS-valikosta.

Järjestelmä lähettää
sinulle siitä viestin.

3 Kaikki CareLink Personal -tilistä haetut uudet tiedot näkyvät potilaan 

raporteissa. 

Synkronointikuvake



CareLink™ Pro -käyttöopas    Laitteiston kokoonpano      31

Laitteiston kokoonpano 5

Luvun sisällys
• Ennen kuin aloitat: sivu 31

• Laitteiden kytkeminen: sivu 32

Tässä luvussa on kaavioita, joiden avulla voit kytkeä potilaan 

laitteen tietokoneeseen ja lukea laitteen tiedot.

Potilaan laitteen on oltava käytössäsi, jotta voit lukea sen tiedot 

suoraan. Voit kuitenkin hakea laitetiedot myös potilaan CareLink™

Personal -tilistä, jos et voi lukea laitetta suoraan.   

Ennen kuin aloitat

Jos haluat lukea tiedot laitteesta suoraan, käytössäsi on oltava 

potilaan laitteen lisäksi tarvittavat kaapelit tai tiedonsiirto-

laitteet.
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Laitteiden kytkeminen 

HUOMAUTUS: Saat
lisätietoja kytkennöistä

noudattamalla

CareLink™ Pro
-näyttöjen ohjeita
laitetietojen luvun

aikana.

Katso yleiskuvasta, miten laitteet kytketään tietokoneeseen 

tiedonsiirtoa varten. Jäljempänä olevissa kaavioissa on kuvattu 

laitekohtaisia tiedonsiirtokytkentöjä. 

HUOMAUTUS: Tässä
esimerkissä käytetään
CareLink-USB-laitetta

pumpun ja tietokoneen
väliseen tiedonsiirtoon.

Laitteiston kokoonpanon yleiskuva               

TM

CareLinkUSB

CareLink-USB-laite

Tietokone

Paradigm-pumppu
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Laitteiston kytkentäkaaviot                                    

                      

Tietokoneen kytkennät

USB-
portti

Sarja-
portti
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kytke
tietokoneen
sarjaporttiin

ComLink, jota käytetään Paradigm-sarjan pumppujen kanssa

Valinnaiset osat

Com-Station, jota käytetään MiniMed 508 -pumppujen kanssa ja mittareiden 
ja tietokoneen välissä
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Devices-työtila 6

Luvun sisällys
• Ennen kuin aloitat: sivu 36

• Laitteen lisääminen: sivu 36

• Laitteen aktivoiminen tai aktivoinnin poistaminen: sivu 41 

• Laitetietojen lukeminen: sivu 42

Potilaan laitteen tietojen lukemiseen tarvittavat tiedot (merkki, 

malli, sarjanumero jne.) tallennetaan Devices-työtilaan. Näin 

sinun ei tarvitse syöttää tietoja joka kerta, kun luet laitetiedot. 

Devices-työtilan laitteet tallennetaan kahteen luetteloon – Active 

Devices- tai Inactive Devices -luetteloon. Kun lisäät laitteen, se 

tallentuu automaattisesti Active Devices -luetteloon. Voit lukea 

tiedot ainoastaan Active Devices -luettelossa näkyvistä laitteista. 

Ne ovat laitteita, joita potilas todennäköisesti käyttää tällä 

hetkellä. 

Muut potilaan laitteet, joita potilas ei käytä tällä hetkellä, 

voidaan tallentaa Inactive Devices -luetteloon. Näin tiedot pysyvät 

tallessa. Nämä laitteet voidaan muuttaa aktiivisiksi milloin 

tahansa.
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Ennen kuin aloitat

Ennen kuin voit avata potilaan Devices-työtilan, potilaan profiilin on 

oltava tallennettuna järjestelmään. Katso luku 4, Profile-työtila.

Jotta voit lisätä laitteet tai lukea sen tiedot suoraan, laitteen on 

oltava yhteydessä tietokoneeseen. Katso luvusta 5, Laitteiston 

kokoonpano, miten laitteet kytketään tietokoneeseen tiedonsiirtoa 

varten.

Laitteen lisääminen         

Voit hakea potilaan CareLink Personal -tilistä tiedot laitteesta, jota ei 

ole vielä lisätty. Järjestelmä lisää nämä laitteet automaattisesti, kun 

se synkronoi tiedot CareLink Personal -tilin ja CareLink Pro -ohjel-

miston välillä.

HUOMAUTUS: Potilasta
kohden voi olla vain

yksi aktiivinen pumppu.
Uuden pumpun

lisääminen siirtää
olemassa olevan

pumpun epäaktiivisten
laitteiden luetteloon.

Medtronic-pumpun tai Guardian-monitorin lisääminen  

1 Varmista, että lisättävä laite on yhteydessä tietokoneeseen. 

(Kytkentävaiheet ovat luvussa 5, Laitteiston kokoonpano.)

2 Valitse potilaan välilehti tai kaksoisnapsauta potilaan nimeä Patient 

Lookup -taulukossa.

3 Avaa potilaan Devices-työtila valitsemalla DEVICES (katso esimerkki 

sivulla 11).

4 Valitse ADD DEVICE.

5 Valitse Medtronic Pump/Guardian. Näkyviin tulee ohjattu toiminto 

Add Medtronic Pump / Guardian.

DEVICES-painike
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HUOMAUTUS:
Pumppumalli on pumpun

takana tai pumpun
tilanäytössä.

6 Määritä lisättävä laite valitsemalla vastaava valintanappi. 

Jos valitsit MiniMed 508 pump -vaihtoehdon, siirry vaiheeseen 9.

7 Valitse NEXT. Näkyviin tulee Serial Number -sivu.

HUOMAUTUS: Näkyviin
tulee virheilmoitus, jos

et syötä oikeaa
sarjanumeroa. Tarkista

tämän sivun esimerkit
ja tarkista, että syötät

oikeat merkit pumpun
takaa. Kirjoita nämä

kuusi merkkiä
tarvittaessa uudelleen.

8 Käytä apuna tämän sivun esimerkkejä ja etsi lisättävän laitteen 

kuusimerkkinen sarjanumero. (Jos tarvitset apua sarjanumeron 

löytämisessä, napsauta >>learn more -linkkiä.) Kirjoita nämä kuusi 

merkkiä Device Serial Number -kenttään.

9 Valitse NEXT. Näkyviin tulee seuraavankaltainen Communication 

Options -sivu.

10 Napsauta avattavaa Choose Port -valikkoa ja valitse tietokoneen 

portti, johon ComLink, Paradigm Link®, CareLink-USB-laite tai 

Com-Station kytketään. Jos et ole varma oikeasta portista, valitse 

Auto Detect (or USB).
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11 Valitse NEXT. Näkyviin tulee seuraavankaltainen Test Connection

-sivu.

12 Noudata mahdollisia laitetta koskevia ohjeita ja valitse TEST.

Näyttöön tulee viesti onnistuneesta yhteydestä. Jos yhteys onnistui, 

siirry seuraavaan vaiheeseen. 

HUOMAUTUS: Tämä
testi ei lue pumpun

tietoja vaan tarkistaa
toimivan yhteyden

pumpun ja tietokoneen
välillä.

Jos yhteys epäonnistui, varmista, että laitteen ja tietokoneen välissä 

oleva laitteisto on kytketty oikein. Napsauta myös ohjatun toiminnon 

sivuilla BACK-painiketta ja varmista, että syöttämäsi laitetiedot ovat 

oikein.

13 Valitse DONE.

Pumppu lisätään potilaan Active Devices -luetteloon.
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Mittarin lisääminen 

1 Valitse potilaan välilehti tai kaksoisnapsauta potilaan nimeä Patient 

Lookup -taulukossa.

2 Varmista, että lisättävä mittari on yhteydessä tietokoneeseen. 

(Kytkentävaiheet ovat luvussa 5, Laitteiston kokoonpano.)

3 Avaa potilaan Devices-työtila valitsemalla DEVICES (katso esimerkki 

sivulla 11).

4 Valitse ADD DEVICE -painike.

5 Valitse Blood Glucose Meter. Näkyviin tulee ohjattu toiminto Add

Blood Glucose Meter.

6 Valitse oikea mittarimerkki valitsemalla vastaava valintanappi.

7 Valitse NEXT. Näkyviin tulee Meter Model -sivu (tämä sivu on 

erilainen mittarin valmistajan mukaan).

8 Valitse lisättävä mittarimalli napsauttamalla. 
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9 Valitse NEXT. Näkyviin tulee Communication Options -sivu.

HUOMAUTUS:
Valittavissa ovat vain

vaihtoehdot, jotka
koskevat lisättävää

mittaria.

10 Napsauta avattavaa Choose Port -valikkoa ja valitse tietokoneen 

portti, johon ComLink, Paradigm Link® tai CareLink-USB-laite 

kytketään. Jos et ole varma oikeasta portista, valitse Auto Detect.

11 Valitse NEXT. Näkyviin tulee Test Connection -sivu.

12 Noudata mahdollisia mittaria koskevia ohjeita ja valitse TEST.

Näyttöön tulee viesti onnistuneesta yhteydestä. Jos yhteys onnistui, 

siirry seuraavaan vaiheeseen. 

Jos yhteys epäonnistui, varmista, että laitteen ja tietokoneen välissä 

oleva laitteisto on kytketty oikein. Napsauta myös ohjatun toiminnon 

BACK-painiketta ja varmista, että olet syöttänyt oikeat tiedot.

13 Valitse DONE.

Mittari lisätään potilaan Active Devices -luetteloon.
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Laitteen aktivoiminen tai aktivoinnin poistaminen 

Potilaan laitteita voidaan siirtää Active Devices- ja Inactive Devices

-luettelon välillä tarpeen mukaan. Laitteen on oltava aktiivinen, jotta 

voit lukea sen tiedot. 

Active Devices -luettelossa voi olla niin paljon mittareita kuin haluat 

mutta vain yksi pumppu. Varmista, että haluat muuttaa epäaktii-

viseksi sillä hetkellä aktiivisen pumpun, ennen kuin lisäät uuden 

pumpun.

Laitteen aktivoinnin poistaminen

1 Valitse potilaan välilehti tai kaksoisnapsauta potilaan nimeä Patient 

Lookup -taulukossa.

2 Avaa potilaan Devices-työtila napsauttamalla DEVICES-painiketta.

HUOMAUTUS: Laitteet
voivat näkyä

luettelossa vastaavalla
laitenimellä. Katso

kohta Vastaavat laitteet
sivulla 5.

3 Poista haluamasi laitteen aktivointi valitsemalla laitteen alta 

>> make this device inactive.

Valittu laite siirtyy Inactive Devices -luetteloon.

Laitteen aktivoiminen uudelleen

1 Valitse potilaan välilehti tai kaksoisnapsauta potilaan nimeä Patient 

Lookup -taulukossa.

2 Napsauta DEVICES-painiketta. Näkyviin tulee potilaan Devices-

työtila.

3 Aktivoi haluamasi laite valitsemalla laitteen alta >> activate this 
device.

Valittu laite siirtyy Active Devices -luetteloon.

Laitteen poistaminen

Voit poistaa laitteen ja sen tiedot Devices-työtilasta ja CareLink Pro 

-järjestelmästä seuraavasti:

1 Valitse potilaan välilehti tai kaksoisnapsauta potilaan nimeä Patient 

Lookup -taulukossa.

2 Avaa potilaan Devices-työtila napsauttamalla DEVICES-painiketta.

3 Varmista, että laite on Inactive Devices -luettelossa. Jos se ei ole, 

valitse sen alta >> Inactivate this device.

4 Poista haluamasi laite valitsemalla sen alta >> delete this device.

Näyttöön tulee viesti, joka varoittaa siitä, että laite ja kaikki sen 

tiedot poistetaan potilastietueesta.
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5 Poista laite valitsemalla YES. 

Laite ja sen tiedot poistuvat Devices-työtilasta ja CareLink Pro 

-järjestelmästä. Tämän laitteen tiedot eivät enää ole käytettävissä 

raporteissa.

Laitetietojen lukeminen

Yksi tapa hakea laitetiedot on muodostaa yhteys potilaan olemassa 

olevaan CareLink Personal -tiliin. (Katso kohta Yhteyden luominen 

CareLink Personal -tiliin (valinnainen) sivulla 26.) Toinen tapa on 

lukea tiedot suoraan laitteesta tämän luvun ohjeiden mukaisesti. 

CareLink Pro -ohjelmisto voi lukea potilaan laitteen tiedot, jos laite 

on Active Devices -luettelossa ja yhteydessä tietokoneeseen. Kun olet 

hakenut tiedot, voit luoda niistä raportteja, joiden avulla voit 

arvioida potilaan hoidon hallintaa. (Lisätietoja raporteista on 

luvussa 7, Reports-työtila.)

Seuraavassa on joitakin tietoja, joita CareLink Pro -järjestelmä kerää 

insuliinipumpusta latauksen aikana:  

• pumpun erilaisia asetuksia, kuten varoitustila, piippauksen 

äänenvoimakkuus ja aikanäyttö

• perusinsuliinin annostellut määrät

• lisäannostapahtumat ja annostellut määrät

• Bolus Wizard -toimintoon syötetyt tiedot

• täyttömäärät

• pysäytysajat

• sensorin glukoosiarvot tietyltä ajanjaksolta pumpuista, joissa on 

sensoritoiminnot.

Järjestelmä kerää myös esimerkiksi seuraavia tietoja 

Guardian REAL-Time -järjestelmästä:

• sensorin glukoosiarvot

• sensorin kerroinarvot

• sensorin kalibrointikertoimet

• ateriamerkit

• insuliinipistokset.

Lisäksi järjestelmään voidaan ladata erilaisia verensokerimittariin 

tallennettuja tietoja laitetta luettaessa. 
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VAARA: Peruuta mahdolliset väliaikaiset perusannokset tai aktiiviset lisäannokset tai 
annostele ne loppuun ja poista mahdolliset aktiiviset hälytykset. Pumppu pysähtyy 
lukemisen ajaksi. Kun luku on päättynyt, varmista, että pumpun annostelu jatkuu.

VAROITUS: Älä käytä pumpun kauko-ohjainta pumpun tietojen luvun aikana. 

Jos pumpun paristo on melkein tyhjä, pumppu ei lähetä tietoja tietokoneeseen. Vaihda 
paristo, jos sen tilailmaisin ilmoittaa heikosta paristosta.    

1 Valitse potilaan välilehti tai kaksoisnapsauta potilaan nimeä Patient 

Lookup -taulukossa.

2 Varmista, että potilaan laite on yhteydessä tietokoneeseen. (Katso 

luku 5, Laitteiston kokoonpano.)

3 Avaa potilaan Devices-työtila napsauttamalla DEVICES-painiketta.

HUOMAUTUS: Laitteet
voivat näkyä

luettelossa vastaavalla
laitenimellä. Katso

kohta Vastaavat laitteet
sivulla 5.

4 Etsi Active Devices -luettelosta laite, jonka tiedot haluat hakea, ja 

varmista, että olet valinnut oikean portin Choose port -valikosta.

– Jos haet pumpun tiedot, napsauta avattavaa Amount of Data
-valikkoa ja valitse, kuinka paljon pumpputietoja haluat hakea 
CareLink Pro -ohjelmistoon.

5 Valitse vastaava READ DEVICE -painike.

6 Noudata laitekohtaisia ohjeita ja valitse OK.

7 CareLink Pro -näytössä näkyy edistymispalkki, joka osoittaa paljonko 

luettavia tietoja on jäljellä.

8 Jos valitset CANCEL laitteen luvun aikana, näyttöön tulee varoitus 

siitä, että toiminnon peruuttaminen voi johtaa siihen mennessä 

luettujen tietojen häviämiseen. Käynnistä lataus uudelleen 

valitsemalla READ DEVICE -painike (vaihe 5).

– Peruuta valitsemalla YES. 

– Jatka laitetietojen lukua valitsemalla NO.

Kun järjestelmä on lukenut laitetiedot, näyttöön tulee vahvistus-

viesti siitä, että laitteen luku on valmis.

9 Valitse OK. 

– Jos luet pumpun tiedot, poista se pysäytystilasta ohjeiden 
mukaisesti.

Jos CareLink Pro -ohjelmisto ei pysty lukemaan laitetietoja, katso 

lisäohjeita luvusta 9, Vianetsintä.
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Reports-työtila 7

Luvun sisällys
• Ennen kuin aloitat: sivu 44

• Raporttien luominen: sivu 45

• Tietoja raporteista: sivu 52

• Tietojen vieminen: sivu 53

CareLink™ Pro -ohjelmiston Reports-työtilassa voit muuntaa 

laitteesta saadut tiedot kliinisesti hyödyllisiksi tiedoiksi. 

Luotavissa olevat raporttityypit on kuvattu kohdassa Tietoja 

raporteista sivulla 52.

Raportit voidaan luoda näytössä, lähettää suoraan tulostimeen tai 

tallentaa TIFF- tai PDF-tiedostoina, jotka voidaan liittää 

sähköiseen potilaskertomukseen (Electronic Medical Record, EMR). 

Voit luoda erilaisia raporttityyppejä yhdellä toiminnolla.

Raporteissa näkyvät tiedot on saatu potilaan laitteista, CareLink 

Personal -tilistä tai molemmista. 

Ennen kuin aloitat

Jos haluat raportin tietyltä ajanjaksolta, sinulla on oltava potilaan 

laitetiedot kyseiseltä ajanjaksolta. Potilaan laite on ehkä myös 

kytkettävä tietokoneeseen, jotta saat senhetkiset tiedot ennen 

raporttien luomista.
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Tarkista huolellisesti Verify Report Settings -vaiheen asetukset, 

ennen kuin luot raportin. Tässä vaiheessa voit hienosäätää raportti-

asetuksia, jotta saat raportteihin haluamasi tiedot.

Raporttien luominen       

Seuraavissa kohdissa kuvataan, miten voit luoda yhden tai useita 

raportteja.

Reports-työtilan avaaminen

1 Valitse potilaan välilehti tai napsauta OPEN PATIENT -painiketta ja 

kaksoisnapsauta potilaan nimeä.

Näyttöön tulee Reports-työtila (katso esimerkki sivulla 11).

HUOMAUTUS: Varmista
SYNC DATA -painiketta

napsauttamalla, että
sinulla on viimeisimmät

laitetiedot potilaan
CareLink Personal

-tilistä.

Raportointiajanjakson valitseminen

1 Voit muuttaa raportissa tai raporteissa näkyvän ajanjakson pituutta 

napsauttamalla avattavaa Duration-valikkoa ja valitsemalla 

ajanjakson pituuden. (Pisin ajanjakso on 12 viikkoa.)

2 Ajanjakson alkamis- ja päättymispäivät määräytyvät automaatti-

sesti, paitsi jos olet valinnut custom date range -vaihtoehdon. 

HUOMAUTUS: Jos
valitset sallittua

pitemmän ajanjakson,
näyttöön tulee

virheilmoitus. Muuta
tällöin kestoa tai

päivämääriä.

Jos haluat mukauttaa ajanjaksoa, napsauta avattavia From- tai 

Through-valikkoja ja valitse haluamasi kuukausi, päivä tai vuosi. 

Tietokalenteri

Reports-työtilan tietokalenterialueella näkyy kolmen kuukauden 

raportointitietojen ikkuna. Ikkuna sisältää laiteluettelon ja 

valittujen kolmen kuukauden aikana kerättyjen tietojen määrän. 

Siinä näkyy myös raportointiajanjakson kesto valituilta kolmelta 

kuukaudelta.

Open Patient
-painike

laitetiedot
raportointiajanjakso

tietokalenteri
kuukaudet
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Jos laitetiedot ja raportointiajanjakso ovat päällekkäisiä, tietoja on 

osalta näytössä näkyvää raportointiajanjaksoa tai koko raportointi-

ajanjaksolta.

Tietokalenterialueella näkyy aluksi kolme viimeksi kulunutta 

kuukautta. Saat näyttöön muut kuukaudet napsauttamalla 

kuukausijanan molemmissa päissä olevia nuolipainikkeita.

Raportteihin sisältyvien lähdetietojen valitseminen

1 Jos potilas käyttää pumppuun linkitettyä verensokerimittaria, valitse 

jokin seuraavista mittarin verensokeritietojen raportointi-

vaihtoehdoista: 

– in the pump: Tämän vaihtoehdon etuna on se, että sinun tarvitsee 
lukea tiedot vain potilaan pumpusta. Verensokeriarvoissa on 
pumpun antama aikaleima, ja ne liittyvät suoraan käytettyihin 
Bolus Wizard -laskelmiin. Vaihtoehdon haittana on se, että jos 
pumpun ja linkitetyn mittarin välillä on tiedonsiirtohäiriöitä, 
kyseisen ajan verensokeriarvot eivät välttämättä näy raportissa. 
Jos käytössä on jokin MiniMed Paradigm -pumpun aiempi versio 
kuin 522/722, raporteissa ei näy myöskään verensokeriarvoja, 
joita käytettiin Bolus Wizard -laskelmissa mutta joiden peruste-
ella ei ryhdytty toimenpiteisiin.

– in the link meter(s): Tämän vaihtoehdon etuna on se, että 
raporteissa näkyvät kaikki linkitettyyn mittariin tallennetut 
arvot. Vaihtoehdon haittana on se, että jos haluat korreloida 
mittarin tiedot pumpun tietojen kanssa, sinun on varmistettava, 
että pumpun ja mittarin kellonajat oli synkronoitu. Sinun on myös 
luettava tiedot pumpusta ja linkitetystä mittarista erikseen.

2 Voit lisätä laitetiedot raportteihin valitsemalla haluamasi laitteen 

vieressä olevan valintaruudun. 

Et voi lisätä laitteita, joiden valinnan poistit vaiheessa 1. Voit 

tarvittaessa valita toisen linkitettyä mittaria koskevan vaihtoehdon.

Päällekkäiset laitetiedot ja 
raportointiajanjakso

nuolipainikkeet
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3 Voit poistaa laitetiedot raporteista poistamalla haluamasi laitteen 

vieressä olevan valintaruudun valinnan. 

Et voi poistaa valintaa laitteilta, jotka valitsit vaiheessa 1. Voit 

tarvittaessa valita toisen linkitettyä mittaria koskevan vaihtoehdon.

Laitetietojen saatavuuden tarkistaminen

1 Katso Reports-työtilan tietokalenterialueelta, ovatko laitetiedot 

päällekkäisiä raportointiajanjakson kanssa (katso esimerkki 

sivulla 46).

2 Jos palkit ovat päällekkäisiä koko raportointiajanjaksolta, raporttia 

tai raportteja varten on tietoja. Valitse NEXT ja siirry kohtaan 

Raporttiasetusten tarkistaminen sivulla 49.

3 Jos palkit eivät ole päällekkäisiä tai jos ne eivät ole päällekkäisiä 

riittävältä ajalta, voit

– muuttaa raportointiajanjaksoa (katso kohta 
Raportointiajanjakson valitseminen sivulla 45)

– hakea ylimääräisiä laitetietoja (katso kohta Ylimääräisten 
laitetietojen hakeminen sivulla 47).

Ylimääräisten laitetietojen hakeminen  

1 Voit hakea lisää tietoja haluamastasi laitteesta napsauttamalla 

laitteen READ DEVICE -painiketta.

Näytössä näkyy laitteen luvun edistymispalkki.

VAARA: Peruuta mahdolliset väliaikaiset perusannokset tai aktiiviset lisäannokset tai 
annostele ne loppuun ja poista mahdolliset aktiiviset hälytykset. Pumppu pysähtyy luvun 
ajaksi. Kun luku on päättynyt, varmista, että pumpun annostelu jatkuu.

VAROITUS: Älä käytä pumpun kauko-ohjainta pumpun tietojen luvun aikana. 

Jos pumpun paristo on vajaa, pumppu ei lähetä tietoja tietokoneeseen. Vaihda paristo, 
jos laitteen tilanäyttö ilmoittaa vajaasta paristosta.    

laitteen luvun edistymispalkki

READ DEVICE -painike
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2 Tarkista, että avattavasta Choose port -valikosta on valittu laitteelle 

oikea vaihtoehto. 

Voit muuttaa asetusta napsauttamalla avattavaa valikkoa ja 

valitsemalla eri asetuksen.

3 Varmista, että laite on kytkettynä tietokoneeseen. 

4 Jos laite on pumppu, voit määrittää, kuinka paljon tietoja haluat 

hakea siitä. Napsauta avattavaa Amount of Data -valikkoa ja valitse 

määrä.

HUOMAUTUS: Jos
valitset vaihtoehdon All

available data,
järjestelmä lukee

pumpusta kaikki tiedot.
Nämä tiedot korvaavat

järjestelmässä
mahdolliset olevat

identtiset tiedot.

5 Napsauta READ DEVICE -painiketta. Lue huolellisesti näyttöön tuleva 

viesti, sillä se sisältää tarkkoja pumpun lukua koskevia ohjeita.

6 Noudata ohjeita ja valitse OK. 

Näytössä näkyy laitteen luvun edistymispalkki.

Voit peruuttaa luvun milloin tahansa napsauttamalla CANCEL-

painiketta.

Näyttöön tulee vahvistusviesti luvun päättymisestä.

7 Valitse OK.

Laitteen tiedot näkyvät nyt tietokalenterissa.

8 Napsauta Reports-työtilan yläreunassa olevaa NEXT-painiketta.

Näyttöön tulee Verify Report Settings -vaihe. Tässä näytössä voit 

varmistaa, että potilaalle valitut asetukset ovat oikein, ennen kuin 

luot raportin tai raportit.

aikajana

ateria-ajanjakso 

ateria-ajanjaksojen muokkauskentät

heräämis- ja nukkumaanmenoajanjaksot
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Raporttiasetusten tarkistaminen 

1 Varmista, että Glucose Target -asetukset ovat oikein. Kirjoita arvot 

tai suurenna tai pienennä arvoja napsauttamalla avattavien Low- ja 

High-valikoiden ylä- tai alanuolipainikkeita.

HUOMAUTUS: Voit
määrittää enintään

viisi ateria-ajanjaksoa.
Oletusateriat ovat

aamiainen, lounas ja
päivällinen.

2 Voit lisätä uuden ateria-ajanjakson napsauttamalla ADD MEAL 

-painiketta. Voit muokata olemassa olevaa ateria-ajanjaksoa 

napsauttamalla mitä tahansa ateria-ajanjakson kohtaa aikajanalla.

Aikajanan alapuolella oleva ateria-ajanjakson editori aktivoituu.

3 Kirjoita haluamasi asetukset tai valitse ne nuolipainikkeilla.

HUOMAUTUS: Jos haluat
käyttää näitä asetuksia

vain kyseiselle ateria-
ajanjaksolle, poista

valintaruudun Use these
parameters for all of this
patient’s meals valinta.

– Meal Name: Nimi, jonka haluat antaa ateria-ajanjaksolle.

– Meal Time Period: Tunnit, joiden välillä ateria nautitaan.

– Pre-Meal BG Target (mg/dL tai mmol/L): Potilaan verensokerin 
tavoitealueen ala- ja yläraja ennen ateriaa.

– Pre-Meal Analysis Period: Ajanjakso, jolta verensokeri 
analysoidaan ennen aterian alkua. Tänä aikana mitattuja 
verensokeriarvoja käytetään yksityiskohtaisessa raportti-
analyysissa.

– Post-Meal BG Target (mg/dL tai mmol/L): Potilaan verensokerin 
tavoitealueen ala- ja yläraja aterian jälkeen.

– Post-Meal Analysis Period: Ajanjakso, jolta verensokeri 
analysoidaan aterian jälkeen. Tänä aikana mitattuja verensokeri-
arvoja käytetään yksityiskohtaisessa raporttianalyysissa.

HUOMAUTUS: Ateria-
ajanjaksot eivät voi

olla päällekkäisiä,
mutta aloitus- ja

lopetusajat voivat olla
samat. Ateria-

ajanjakson pituuden on
oltava vähintään

60 minuuttia.

Voit muuttaa olemassa olevan ateria-ajanjakson tai heräämis- ja 

nukkumaanmenoajanjakson pituutta napsauttamalla aloitus- tai 

lopetusviivoja ja vetämällä niitä aikajanalla. 

napsauta aloitus- tai lopetusviivaa ja vedä sitä aikajanalla

aikajana

mittariarvojen merkit
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4 Voit käyttää tämän aterian asetuksia kaikille potilaan aterioille 

valitsemalla valintaruudun Use these parameters for all of this 

patient’s meals.

5 Kun olet lopettanut ateria-ajanjakson luomisen tai muokkaamiseen, 

valitse SAVE.

6 Voit poistaa ateria-ajanjakson napsauttamalla DELETE MEAL 

-painiketta. Valitse DELETE, kun näyttöön tulee vahvistuspyyntö.

7 CareLink Pro -ohjelmisto voi tallentaa nämä asetukset potilaalle 

seuraavaa raportointikertaa varten. Voit tallentaa asetukset poti-

laalle napsauttamalla SAVE SETTINGS -painiketta.

8 Napsauta Reports-työtilan yläreunassa olevaa NEXT-painiketta. 

Tämä on luontitoiminnon Select and Generate Reports -vaihe. Se 

sisältää raporttityyppiluettelon ja tietotaulukon, jonka avulla voit 

lisätä Daily Detail -raporttiin tiettyjen päivien tiedot tai poistaa 

tiettyjä päiviä. 

9 Voit tulostaa näytön tiedot napsauttamalla tulostuskuvaketta.

HUOMAUTUS: Voit
mukauttaa

tietotaulukkonäyttöä
napsauttamalla

>>customize columns
-linkkiä. Katso kohta

Raporttien
luontiasetukset

sivulla 22.

Raporttityyppien ja -päivämäärien valitseminen 

1 Valitse luotavaan raporttiryhmään haluamasi raportit valitsemalla 

niiden valintaruudut.

2 Jos olet lukenut tiedot pumpusta tai Guardian-monitorista useammin 

kuin kerran raportointiajanjakson aikana, Device Settings Snapshot 

-raportteja voi olla useita: 

tietotaulukko

tulos-
tusku-

vake
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a. Varmista, että Device Settings Snapshot -valintaruutu on 
valittuna. 

b. Napsauta avattavan valikon nuolipainiketta ja valitse 
laiteasetusraportin päivämäärä ja kellonaika. 

– Pumps: Valitse potilaan pumpun laiteasetusraportti.

– Guardian: Valitse potilaan Guardian-monitorin laiteasetus-
raportti. 

Jos molemmat kentät on himmennetty, kyseiseltä raportointi-

ajanjaksolta ei ole laiteasetusraportteja.

3 Katso käytettävissä olevat Daily Detail -raporttitiedot selaamalla 

tietotaulukkoa. 

– Voit lajitella jokaisen sarakkeen tiedot. Lajittele tiedot 
nousevaan järjestykseen napsauttamalla sarakkeen otsikkoa. 
Lajittele tiedot laskevaan järjestykseen napsauttamalla 
sarakkeen otsikkoa uudelleen.

HUOMAUTUS: Jos
tietyltä päivältä ei ole
tietoja, kyseinen päivä

ei ole valittavissa.

4 Valitse tietotaulukosta niiden päivämäärien valintaruudut, joilta 

haluat Daily Detail -raportin. 

– Voit lisätä tai poistaa kaikki Daily Detail -raportin päivämäärät 
yhdellä napsautuksella valitsemalla tietotaulukon valintaruu-
tusarakkeen ylimmän valintaruudun tai poistamalla sen valinnan.

Raporttien luominen  

1 Kun olet tarkistanut raporttivalinnat, napsauta Reports-työtilan 

yläosassa olevaa GENERATE REPORTS -painiketta.

Näyttöön tulee vaihtoehtoluettelo.

2 Valitse haluamasi vaihtoehto: raportin/raporttien esikatselu, 

tulostus tai tallennus.

Jos valitset Preview-vaihtoehdon, näyttöön tulee Report Preview

-ikkuna.

3 Selaa monisivuisia raportteja napsauttamalla nuolipainikkeita.

4 Tallenna tai tulosta raportti tai raportit napsauttamalla Report 

Preview -ikkunan yläreunan vastaavia painikkeita.

5 Voit sulkea ikkunan napsauttamalla sen oikeassa yläkulmassa olevaa 

CLOSE-painiketta.Esikatselun CLOSE-
painike
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Tietoja raporteista 

Tässä kohdassa kuvataan kukin raporttityyppi. Lisätietoja raportin 

osioista sekä esimerkkiraportteja on raporttioppaassa. Voit avata 

raporttioppaan CareLink Pro -ohjelmistosta seuraavasti:

1 Valitse Help > View Report Reference Guide (PDF).

2 Valitse raporttioppaan kieli.

CareLink Pro -raporteilla on seuraavat yleiset ominaisuudet: 

• Raportin otsikko  Raportin otsikko sisältää tunnistetietoja, kuten 

raportin nimen, potilaan nimen ja tietolähteen.

• Hiilihydraatit ja verensokeriarvot  Hiilihydraattiyksiköt näkyvät 

käyrissä ja kaavioissa kursivoituina ja verensokeriarvot lihavoituina.

• Viikonlopun tiedot  Viikonlopun päivät näkyvät lihavoituina, jotta ne 

erottuvat helposti.

• Symbolien selitykset  Symbolien selitykset näkyvät kunkin raportin 

alareunassa. Joitakin symboleita käytetään useissa raporteissa, 

mutta jotkin symbolit ovat raporttikohtaisia.

Adherence-raportti

Tämä raportti sisältää tietoja, jotka kuvaavat insuliinipumppujen ja 

sensoreiden käyttöä ja potilaan omahoitoa. Se vastaa seuraavin 

kysymyksiin: ”Oliko käytettävissä riittävästi tietoja, jotta saan tarkan 

kuvan siitä, miten potilas käyttää insuliinipumppua ja sensoria (jos 

käytössä)? Noudattavatko potilaat annettuja hoito-ohjeita?” Raportti 

osoittaa myös, onko sinun keskusteltava potilaan kanssa diabeteksen 

omahoidosta.

Sensor & Meter Overview -raportti

Sensor & Meter Overview Report -raportti on graafinen esitys potilaan 

vuorokausikohtaisista mittarin verensokeriarvoista ja keskiarvoista. 

Lisäksi se sisältää tuntikohtaiset arvot 24 tunnin ajalta ja niiden 

suhteen aterioihin ja nukkumisrytmiin. Raportti sisältää myös 

potilaan sensorin glukoosiarvojen tilastotiedot ja insuliinin käytön. 

Jos sensoritietoja on käytettävissä, raportin ensimmäisellä sivulla on 

samankaltainen sensoritietojen analyysi. Jos sensoritietoja ei ole 

käytettävissä, ensimmäisellä sivulla on mittariarvojen analyysi.
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Raportin viimeisellä sivulla tai viimeisillä sivuilla on vuorokausi-

kohtaiset potilaan glykemian, hiilihydraattien ja insuliinin hallintaa 

kuvaavat arvot. Kukin sivu näyttää, miten hallinta vaihtelee 

raportointiajanjakson kunkin vuorokauden aikana. Yhdellä sivulla 

näkyvät enintään 14 vuorokauden tiedot.

Logbook-raportti

Logbook-raportti sisältää mittarin verensokeritiedot sekä hiili-

hydraatti- ja insuliinitiedot raportointiajanjakson jokaiselta vuoro-

kaudelta. Raportti sisältää tuntikohtaisen tapahtumalokin sekä 

vuorokausikohtaiset keskiarvot ja kokonaismäärät. Kukin sivu sisältää 

enintään 14 vuorokautta. Jos raportointiajanjakso on yli 

14 vuorokautta, raportissa on lisäsivuja.

Device Settings Snapshot -raportti

Tämä raportti sisältää potilaan pumpun tai Guardian REAL-Time 

-monitorin laiteasetukset tiettynä päivänä ja kellonaikana. Voit 

käyttää raporttia apuna muiden raporttien tulkinnassa tai potilaan 

laiteasetusten dokumentointiin. 

Pumpun tai monitorin asetukset tallentuvat vain, kun laitetiedot 

luetaan. Jos laitetta ei luettu raportointiajanjakson aikana, asetuksia 

ei ole käytettävissä.

Daily Detail -raportti

Daily Detail -raportti sisältää glukoositiedot, hiilihydraattimäärät ja 

potilaan insuliinin käytön valitulta vuorokaudelta. Järjestelmä luo 

erillisen raportin jokaiselle vuorokaudelle, jonka valitset tietotau-

lukosta.

Daily Detail -raportti sisältää yksityiskohtaiset tiedot valitsemaltasi 

vuorokaudelta. Sen avulla voit keskittyä tiettyyn vuorokauteen, jos 

potilaan hoidossa tapahtui jotain mielenkiintoista sen aikana.

Tietojen vieminen

Voit tallentaa CareLink Pro -ohjelmiston keräämät ja tallentamat 

laitetiedot vientitiedostoon. Näin voit käyttää potilaan kaikkia 

laitetietoja tilastointiin tai erityisten raporttien tai kaavioiden 

luontiin. Voit tuoda .csv-tiedoston Microsoft Exceliin tai tiettyihin 

kliinisiin tilastointiohjelmiin, joissa voit muokata tietoja lisää.
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CSV-tiedosto sisältää tietoja laitteen toiminnoista. Se luetteloi 

esimerkiksi mittariarvojen tallennuksen, pumpun vastaanottamat 

mittariarvot tai perusannoksen muutoksen.

HUOMAUTUS: Tämä on
edistyneiden käyttäjien

toiminto, joka
edellyttää laitteen

raakatietojen
tuntemista. Sinun on

myös osattava käyttää
ohjelmistoa, johon tuot

.csv-tiedoston.

Käytä CareLink Pro -vientitoimintoa seuraavasti:

1 Valitse potilaan välilehti tai napsauta OPEN PATIENT -painiketta ja 

kaksoisnapsauta potilaan nimeä.

2 Varmista, että näytössä näkyy Reports-työtila.

3 Määritä raportin päivämäärät ja pituus Duration- tai From/Through-

valikoihin.

Pisin ajanjakso, jonka voit valita, on 12 viikkoa.

4 Napsauta export selected data -linkkiä.

Näyttöön tulee Export Data to CSV File -valintaikkuna.

5 Jos haluat vaihtaa .csv-tiedoston tallennussijainnin tietokoneessa, 

napsauta avattavan Save in -valikon oikealla puolella olevaa 

nuolipainiketta ja valitse sijainti.

6 Jos haluat muuttaa tiedoston nimeä, kirjoita se File name -kenttään.

7 Valitse SAVE.

HUOMAUTUS:
Lisätietoja CSV-

tiedostoissa näkyvistä
tiedoista on kohdassa

CSV-tiedot sivulla 64.

CSV-tiedosto on nyt tallennettu tietokoneeseen valitsemaasi 

paikkaan. Nyt voit tuoda sen mihin tahansa ohjelmaan, joka tukee 

tätä tiedostotyyppiä.

export selected 
data -linkki
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Järjestelmänvalvonta 8

Luvun sisällys
• Ennen kuin aloitat: sivu 55

• Ohjelmistopäivitysten asentaminen: sivu 56

• Tietokannan varmuuskopioiminen ja palauttaminen: sivu 57

On tärkeää, että varmuuskopioit CareLink™ Pro -tietokannan 

säännöllisesti. Tietokantaan tallentuvat kaikki järjestelmän 

tiedot, jotka ovat kertyneet potilastietueisiin, kuten profiili-

tiedot, laitteista haetut tiedot ja raporttiasetukset. 

Voit tallentaa kopioita CareLink Pro -tietokannasta ja palauttaa 

ne.

On myös tärkeää, että käytät uusinta CareLink Pro -versiota. 

Ohjelmistoon on saatavilla ajoittain päivitettyjä versioita, joissa 

voi olla tärkeitä parannuksia. Voit hakea ohjelmistopäivitykset 

manuaalisesti tai valita automaattisen ilmoituksen saatavilla 

olevista päivityksistä.

Ennen kuin aloitat

On hyvä määrittää säännöllinen aikataulu tietokannan varmuusko-

piointiin. Näin varmistat, että varmuuskopiointi tehdään säännölli-

sesti, ja minimoit tietojen häviämisriskin. 

Kun varmuuskopiointi tai palautus käynnistetään, CareLink Pro 

tunnistaa käyttäjät, jotka käyttävät ohjelmistoa muilla 

tietokoneilla, ja kehottaa heitä tallentamaan työnsä. Tästä 



CareLink™ Pro -käyttöopas    Järjestelmänvalvonta      56

huolimatta on hyvä tarkistaa ennen varmuuskopiointia tai palautusta, 

että ohjelmisto ei ole parhaillaan muiden käyttäjien käytössä.

Ohjelmistopäivitysten asentaminen

Päivitysten automaattinen vastaanottaminen

CareLink Pro -ohjelmistoa päivitetään ajoittain. Kun näyttöön tulee 

ilmoitus päivityksestä, lataa uusin ohjelmistoversio seuraavasti.

HUOMAUTUS:
Varmuuskopioi

tietokanta, ennen kuin
lataat ohjelmistopäivi-

tyksen. Katso kohta
Tietokannan

varmuuskopioiminen
sivulla 57.

1 Varmista, että Internet-yhteys on käytettävissä ja auki tieto-

koneessa.

2 Näyttöön tulee CareLink Pro Update -viesti, kun CareLink Pro 

-ohjelmistoon on saatavilla päivitys. Viesti antaa mahdollisuuden 

ladata päivityksen.

3 Valitse DOWNLOAD. (Jos valitset CANCEL, päivitysilmoitus sulkeutuu. 

Voit ladata päivityksen myöhemmin.)

Näyttöön tulee varoitusviesti, joka kehottaa varmuuskopioimaan 

tietokannan.

4 Luo tietokannasta varmuuskopio valitsemalla YES (ohjeet ovat 

kohdassa Tietokannan varmuuskopioiminen sivulla 57). Valitse NO, 

jos et halua varmuuskopioida tietokantaa.

Näyttöön tulee viesti, joka vahvistaa uuden CareLink Pro -version 

latauksen.

5 Aloita uusimman CareLink Pro -version käyttö valitsemalla YES, 

jolloin sovellus sulkeutuu ja käynnistyy uudelleen. Valitse NO, jos et 

halua käynnistää CareLink Pro -ohjelmistoa heti uudelleen.

Automaattisten päivitysilmoitusten poistaminen käytöstä

Jos et halua automaattista ilmoitusta CareLink Pro -päivityksistä, 

toimi seuraavasti:

1 Valitse Tools > Options.

2 Napsauta General-välilehteä.

3 Poista Communications-osiossa olevan Automatically check for 

software updates -valintaruudun valinta.
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Päivitysten saatavuuden tarkistaminen manuaalisesti

Voit tarkistaa CareLink Pro -päivitysten saatavuuden manuaalisesti 

milloin tahansa.

HUOMAUTUS:
Varmuuskopioi

tietokanta, ennen kuin
lataat ohjelmisto-
päivityksen. Katso
kohta Tietokannan

varmuuskopioiminen
sivulla 57.

1 Varmista, että Internet-yhteys on käytettävissä ja auki 

tietokoneessa.

2 Valitse Tools > Check for Software Updates

3 Näyttöön tulee viesti, jos päivityksiä ei ole sillä hetkellä saatavilla. 

Jos päivitys on saatavilla, näyttöön tulee CareLink Pro Update 

-viesti. 

4 Toimi kuten kohdassa Päivitysten automaattinen vastaanottaminen 

sivulla 56.

Tietokannan varmuuskopioiminen ja 
palauttaminen

Tietokannan varmuuskopioiminen

Voit varmuuskopioida senhetkisen tietokannan valitsemaasi paikkaan 

seuraavasti.

1 Varmista, että kaikki potilastietueet on suljettu.

2 Valitse Tools > Backup Database.

HUOMAUTUS: Voit
tallentaa tietokannan

varmuuskopiot
verkkoasemaan tai

siirrettävään
tallennusvälineeseen
(DVD- tai CD-levylle,

USB-asemaan jne.).

3 Jos haluat vaihtaa varmuuskopion tallennussijainnin tietokoneessa, 

napsauta Save in -valikon oikealla puolella olevaa nuolipainiketta ja 

valitse uusi sijainti.

4 Jos haluat muuttaa varmuuskopiointitiedoston nimeä, kirjoita se File 

name -kenttään.

5 Valitse SAVE. Näytössä näkyy tietokannan tallentumisen edistymis-

palkki.

Kun varmuuskopiointi on valmis, näyttöön tulee viesti.

6 Sulje viesti valitsemalla OK.

Tietokannan palauttaminen   

Käytössä oleva tietokanta on ehkä korvattava, jos sitä ei pystytä enää 

avaamaan tai käyttämään.

VAROITUS: Kun palautat varmuuskopion, menetät kaikki uudet tiedot, jotka on luotu 
valitun varmuuskopion tallentamisen jälkeen.
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Voit valita nykyisen tietokannan korvaavan varmuuskopion 

seuraavasti.

1 Varmista, että kaikki potilastietueet on suljettu.

2 Valitse Tools > Restore Database.

3 Valitse varmuuskopiointitiedosto, jolla haluat korvata nykyisen 

tietokannan (tavallisesti se on uusin varmuuskopio).

4 Valitse OPEN. Näyttöön tulee varoitusviesti. Valitse OK.

5 Näytössä näkyy tietokannan palauttamisen edistymispalkki.

Kun tietokanta on palautettu, näyttöön tulee viesti.

6 Sulje viesti valitsemalla OK.

Kun järjestelmä ei ole käytettävissä                

Jos yrität käynnistää järjestelmän, kun toinen käyttäjä tekee 

varmuuskopiointia tai palauttaa tietoja, saat viestin, että järjestelmä 

ei ole käytettävissä. Et voit käyttää järjestelmää, ennen kuin 

toiminto on valmis.

Toimi jommallakummalla tavalla:

• Odota, kunnes toiminto on valmis ja järjestelmä on jälleen 

käytettävissä.

• Sulje ikkuna valitsemalla CANCEL ja yritä myöhemmin uudelleen.
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Vianetsintä 9

Luvun sisällys
• Sovelluksen yleiset käyttövirheet: sivu 59

• Laitteiden lukuvirheet: sivu 60

• Raporttien luontivirheet: sivu 61

• Varmuuskopioimisen ja palauttamisen virheet: sivu 62

• Ohjelmiston poistaminen: sivu 62

Tämän luvun avulla voit ratkaista ongelmia, jotka voivat esiintyä 

CareLink™ Pro -ohjelmiston käytön aikana. Luku sisältää myös 

ohjeet CareLink Pro -ohjelmiston poistoon, jos se on tarpeen.

Sovelluksen yleiset käyttövirheet

Käyttöoikeudet ohjelmistopäivitysten lataukseen Internetin kautta

Jos yrität ladata ohjelmistopäivityksen Internetin kautta, näyttöön 

voi tulla viesti, jonka mukaan sinulla ei ole riittäviä käyttöoi-

keuksia. Sinulla on oltava järjestelmänvalvojan käyttöoikeudet, 

jotta voit ladata CareLink Pro -ohjelmistopäivityksiä.

1 Sulje CareLink Pro -ohjelmistosovellus ja käynnistä tietokone 

uudelleen. 

2 Pyydä toista käyttäjää, jolla on järjestelmänvalvojan käyttöoi-

keudet, kirjautumaan tietokoneeseen.

3 Toimi kuten kohdassa Ohjelmistopäivitysten asentaminen 

sivulla 56.
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Ei tietokantayhteyttä

Jos näyttöön tulee viesti, jonka mukaan tietokantayhteyttä ei ole, 

siihen voi olla seuraavia syitä:

• Tietokanta on siirretty. Tietokannan on oltava samassa paikassa, joka 

valittiin CareLink Pro -ohjelmiston asennuksen yhteydessä. Jos 

tietokanta on siirretty, se on siirrettävä takaisin asennuksen 

yhteydessä valittuun paikkaan.

• Tietokone ei ole yhteydessä verkkoasemaan, jossa tietokanta 

sijaitsee. Jos tietokanta on verkkoasemassa, verkossa voi olla 

ajoittain häiriöitä, jotka estävät aseman käytön. Ota yhteys 

tietokonetukeen ja pyydä ohjeita, miten saat yhteyden tietokannan 

sisältävän verkkoasemaan. 

CareLink Pro -ohjelmiston laitoksen salasana unohtunut

Jos kukaan ei muista laitoksen salasanaa, jolla kirjaudutaan CareLink 

Pro -ohjelmistoon, CareLink Pro -ohjelmisto täytyy asentaa uudelleen 

ja täytyy luoda uusi tietokanta. Kun ohjelmisto on asennettu 

uudelleen, aiemmassa tietokannassa olleita potilastietoja ei voi enää 

käsitellä. Tallenna uuden asennuksen aikana luotu salasana johonkin 

paikkaan toimistossa, jotta uusia tietoja ei menetetä. 

Laitteiden lukuvirheet

Laitteen lukuvirhe Merkitys

The selected serial port 
could not be opened. 
Another operation might be 
in progress on that port. 
Please wait until the port is 
available, or select another 
port.

Tarkista, että valittu COM-portti ei ole toisen 
ohjelman käytössä, tai valitse toinen portti. 
Käynnistä käyttämäsi tietokone uudelleen ja yritä 
lukea laitetiedot uudelleen. Porttiin kytketyssä 
laitteistossa (kaapelissa jne.) tai itse portissa voi 
olla vikaa. Kytke laitteisto toiseen porttiin ja 
yritä lukea laitetiedot uudelleen ongelman 
määrittämiseksi. 

Auto Detect could not find 
the device on any available 
port. Please check the cable 
connection, device battery & 
status and try again, or try 
specifying a serial port.

Tarkista kaapelin ja tietokoneen kytkentä ja 
varmista, että laitteen paristo on kunnossa. Jos 
näissä ei ole vikaa, yritä määrittää tietokoneen 
sarjaportti, johon kaapeli on kytketty, Auto 
Detect -toiminnon käyttämisen sijasta.

Device not found at selected 
serial port. Please check the 
cable connection, device 
battery & status and try 
again, try selecting a 
different port, or try to Auto 
Detect the device.

Tarkista kaapelin ja tietokoneen kytkentä ja 
varmista, että laitteen paristo on kunnossa. Jos 
näissä ei ole vikaa, yritä valita tietokoneen eri 
sarjaportin numero tai valitse Auto Detect 
-vaihtoehto.
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Raporttien luontivirheet

Samalle päivälle syötetyt useat tiedot

Jos samalle päivälle ja kellonajalle on syötetty useita saman laitteen 

tietoja, järjestelmä pitää tätä ratkaisemattomana ristiriitana. Tämän 

laitteen tietoja sisältävissä raporteissa ei näy päällekkäisiä tietoja. 

Voit yrittää muuttaa raportointiajanjaksoa, jotta päällekkäiset tiedot 

jäävät raportin ulkopuolelle. Vaihtoehtoisesti voit poistaa laitteen 

järjestelmästä ja lisätä sen uudelleen, jotta edelliset arvot poistuvat.

Unable to communicate with 
the device. Please ensure 
you’ve attached and 
selected the correct device, 
check the cable connection, 
device battery and status, 
and try again.

Tarkista kaikki laitteen luvulle valitut asetukset, 
kuten laitteen nimi, sarjanumero ja 
kytkentätyyppi. Varmista myös, että laite, 
kaapeli ja tietokone on kytketty oikein. Tarkista, 
että laitteen paristo on kunnossa eikä laitteessa 
ole hälytyksiä. Yritä lukea laite uudelleen.

Unexpected response... 
retrying (n%)

Ohjelmisto luki laitteesta uuden odottamattoman 
arvon. Järjestelmä yrittää tiedonsiirtoa, kunnes 
peruutat sen tai tiedonsiirto onnistuu.

The communication device 
was found, but the pump 
(<serial #>) is not 
responding. Please verify the 
pump’s serial number, place 
the pump closer to the 
communication device to 
minimize interference, 
check pump battery and 
status.

Tarkista, että olet syöttänyt pumpun 
sarjanumeron oikein. Jos numero on väärin, syötä 
oikea sarjanumero. Jos sarjanumero on oikein, 
yritä siirtää pumppua lähemmäs tiedonsiir-
tolaitetta tai siirtää tiedonsiirtolaite ja pumppu 
kauas mahdollisista häiriölähteistä (kuten muista 
radiotaajuuslaitteista) tai tarkistaa pumpun 
paristojen ja annostelun tila.

This pump is delivering a 
temp basal. Please cancel 
the temp basal or wait until 
it completes, and then try 
again.

Pumppu, jonka tietoja yrität lukea, annostelee 
parhaillaan väliaikaista perusannosta. Odota, 
kunnes väliaikainen perusannos on annosteltu 
loppuun tai peruuta väliaikainen perusannos ja 
lue sitten pumpun tiedot.

This pump has active errors 
or alarms. Please clear the 
alarms and try again.

Pumpussa on aktiivisia hälytyksiä, jotka estävät 
sen tietojen luvun. Lue hälytysohjeista, miten 
hälytys kuitataan. Kuittaa hälytys ja yritä lukea 
pumpun tiedot uudelleen.

This pump is delivering a 
bolus. Please cancel the 
bolus or wait until it 
completes, and then try 
again.

Pumppu, jonka tietoja yrität lukea, annostelee 
parhaillaan lisäannosta. Odota, kunnes lisäannos 
on annosteltu loppuun tai peruuta lisäannos ja lue 
sitten pumpun tiedot.

The device returned invalid 
entries; all data read will be 
discarded.

Ota yhteys oman maasi edustajaan (katso kohta 
Tuotetuki sivulla 3).

Laitteen lukuvirhe Merkitys
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Järjestelmän huomioimatta jättämät tiedot

Jos laitteen kellonaikaa on muutettu niin, että tuloksena on 

päällekkäisiä tietoja tai aukkoja tiedoissa vähintään kolmen tunnin 

ajalta, järjestelmä ei sisällytä tätä osuutta raportteihin.

Varmuuskopioimisen ja palauttamisen virheet

Tietokantaa ei voi lukita

Tämä tarkoittaa, että käytät järjestelmää usean käyttäjän 

ympäristössä ja että muita käyttäjiä on kirjautuneina järjestelmään. 

Järjestelmän tietokantaa ei voi varmuuskopioida, kun muut käyttäjät 

käyttävät mahdollisesti toimintoja, jotka voivat vaikuttaa tieto-

kantaan. Kun kaikki muut käyttäjät sulkevat CareLink Pro -ohjel-

miston, voit varmuuskopioida tietokannan.

Tietokannan varmuuskopioiminen tai palauttaminen ei valmistu

Muut käyttäjät eivät voi kirjautua ohjelmistoon eikä varmuuskopiointi 

tai palautus valmistu. Ota yhteys puhelinpalveluun tai oman maasi 

paikalliseen edustajaan (katso kohta Tuotetuki sivulla 3).

Tietokannan palauttaminen epäonnistuu

Tietokannan varmuuskopiotiedosto, jonka yrität palauttaa, on 

vioittunut. Yritä palauttaa eri varmuuskopiotiedosto.

Ohjelmiston poistaminen

Voit tarvittaessa poistaa CareLink Pro -ohjelmiston seuraavasti:

1 Avaa Control Panel Windowsin Start-valikosta.

2 Valitse Add or Remove Programs. Näkyviin tulee Windowsin Add or 

Remove Programs -valintaikkuna.

3 Selaa luetteloa kohtaan Medtronic Carelink Pro ja napsauta sitä.

4 Valitse REMOVE. Näyttöön tulee InstallShield Wizard.

5 Valitse NEXT. Näyttöön tulee viesti, joka kehottaa sinua vahvis-

tamaan, että haluat poistaa sovelluksen.

6 Valitse YES. Poisto-ohjelma käynnistyy ja poistaa ohjelman ja kaikki 

sen tiedostot tietokoneesta. Kun toiminto on valmis, ohjatun poisto-

toiminnon ikkunaan tulee vahvistusviesti ohjelman poistosta.

7 Valitse FINISH.
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Kuvaketaulukko
Seuraavassa taulukossa on kuvattu pakkausmerkintöjen ja tuotteen 

kuvakkeet ja symbolit.

Kuvaus Kuvake

Yksi kappale pakkauksessa (1x)

Huomio: Lue käyttöohjeet

Mukana CD

Mukana tärkeitä asiakirjoja

Tuotenumero REF

Lääkinnällisen laitteen CE-merkintä ja 
ilmoitetun laitoksen numero
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Li
it

e 
A

CSV-tiedot A

Tässä liitteessä kuvataan CareLink™ Pro -ohjelmiston tiedot, jotka 

näkyvät CSV-formaattiin tallennetun vientitiedoston sarakkeissa. 

Sarakkeiden tietojen kuvaukset

Sarakkeen otsikko Kuvaus

Index Järjestys, jossa tiedot tallennettiin laitteeseen.

Date Päivämäärä, jolloin tiedot tallennettiin 
laitteeseen.

Time Kellonaika, jolloin tiedot tallennettiin 
laitteeseen.

New Device Time Uusi päivämäärä ja kellonaika, jos niitä 
muutettiin laitteessa.

BG Reading (mg/dL tai 
mmol/L)

Mittarin, Guardian-monitorin tai pumpun tallen-
tama verensokeriarvo. Jos tiedot ovat pumpusta 
tai Guardian-monitorista, sarakkeessa näkyvät 
manuaalisesti syötetyt verensokeriarvot ja 
linkitetystä mittarista saadut verensokeriarvot. 

Linked BG Meter ID Sen linkitetyn mittarin sarjanumero, joka lähetti 
tietyn verensokeriarvon laitteeseen.

Basal Rate (U/h) Aktiivinen perusannos eli perusinsuliinin 
annostelunopeus yksiköinä tunnissa.

Temp Basal Amount 
Jos pumpulla on annosteltu väliaikaisia perus-
annoksia, tässä näkyy väliaikaisen perusannoksen 
määrä. 

Temp Basal Type Väliaikaisen perusannoksen tyyppi (insuliiniyksik-
kömäärä tai prosenttiosuus perusannoksesta).

Temp Basal Duration (m) Väliaikaisen perusannoksen kesto minuutteina 
(katso yllä kuvattu tyyppi).
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Bolus Type

Lisäannoksen tyyppi: normaali lisäannos, jatkettu 
lisäannos, yhdistelmälisäannoksen normaali osuus 
tai jatkettu osuus [Normal, Square, Dual (normal 
part) tai Dual (square part)].

Bolus Volume Selected (U) Valittu insuliiniyksikkömäärä, joka annostellaan 
lisäannoksen annostelun aikana.

Bolus Volume Delivered (U) Todellinen insuliiniyksikkömäärä, joka annos-
teltiin lisäannoksen annostelun aikana.

Programmed Bolus Duration 
(h)

Jatketun lisäannoksen tai yhdistelmälisäannoksen 
jatketun osuuden kesto.

Prime Type

Manuaalinen tai vakio. Manuaalista täyttöä 
käytetään sen jälkeen kun pumppu on palautettu 
alkuasentoon. Sillä täytetään infuusiosetin letku 
ennen sen kiinnittämistä kehoon. Vakiotäyttöä 
käytetään sen jälkeen kun infuusiosetti on 
kiinnitetty kehoon. Sillä täytetään pehmeä 
kanyyli insuliinilla sisäänvientineulan irrottamisen 
jälkeen.

Prime Volume Delivered (U) Täytön aikana annosteltu todellinen insuliini-
yksikkömäärä.

Alarm Esiintyneen hälytyksen nimi.

Suspend Ilmaisee, että pumppu on pysähtynyt.

Rewind Päivä ja kellonaika, jolloin laite on palautettu 
alkuasentoon.

BWZ Estimate (U) Arvioitu lisäannosmäärä, joka on laskettu 
Paradigm-pumpun Bolus Wizard -toiminnolla.

BWZ Target High BG (mg/dL 
tai mmol/L)

Verensokerin tavoitealueen yläraja, jota Bolus 
Wizard -toiminto käyttää.

BWZ Target Low BG (mg/dL 
tai mmol/L)

Verensokerin tavoitealueen alaraja, jota Bolus 
Wizard -toiminto käyttää.

BWZ Carb Ratio

Insuliini-hiilihydraattisuhteen asetus. Jos 
yksikkönä käytetään grammoja, suhdeluku 
osoittaa hiilihydraattigrammat, jotka yksi 
insuliiniyksikkö kattaa. Jos yksikkönä käytetään 
vaihtoannoksia, suhdeluku osoittaa insuliini-
yksiköt, jotka kattavat yhden vaihtoannoksen.

BWZ Insulin Sensitivity

Insuliiniherkkyyden asetus. Insuliiniherkkyys 
osoittaa, kuinka paljon yksi insuliiniyksikkö laskee 
verensokeria. Bolus Wizard -toiminto käyttää tätä 
asetusta.

BWZ Carb Input Bolus Wizard -toimintoon syötetty hiilihydraattien 
määrä, jota käytetään lisäannoksen arviointiin.

BWZ BG Input (mg/dL tai 
mmol/L)

Bolus Wizard -toimintoon syötetty verensokeri-
arvo, jota käytetään lisäannoksen arviointiin.

BWZ Correction Estimate (U) Bolus Wizard -toiminnon laskema lisäannoksen 
yksikkömäärä, jolla korjataan verensokeri.

BWZ Food Estimate (U)
Bolus Wizard -toiminnon laskema lisäannoksen 
yksikkömäärä, jolla katetaan arvioitu nautittava 
hiilihydraattimäärä.

Sarakkeen otsikko Kuvaus
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Lisätietoja CareLink Pro -ohjelmistolla 
tallennetuista CSV-tiedostoista

CSV-tiedoston yläreunassa oleva otsikko sisältää seuraavat tiedot:

• potilaan nimi

• valittujen laitteiden ja niiden sarjanumeroiden luettelo

• valittu päivämääräalue.

Jokaisella sarakeryhmällä on otsikko, joka sisältää seuraavat tiedot:

• laitteen nimi, jota sarakeryhmä koskee

• laitteen sarjanumero. 

Poikkeamat tietojen odotetusta järjestyksestä

CSV-tiedot voivat näkyä muussa kuin odotetussa järjestyksessä useista 

syistä johtuen.

• Laitteen päivämäärän tai kellonajan muutokset voivat muuttaa 

tietojen järjestystä tai johtaa siihen, että tiedostossa näkyy tietoja 

valitun päivämääräalueen ulkopuolelta.

• Jos laitetietojen lukukertojen välissä on pitkä tauko, kyseisen 

laitteen tietoja voi näkyä useissa sarakeryhmissä.

BWZ Active Insulin (U)

Edellisistä lisäannoksista elimistössä jäljellä oleva 
laskettu aktiivisen insuliinin määrä, jota Bolus 
Wizard -toiminto käyttää laskiessaan arvioitua 
lisäannosta.

Sensor Calibration BG 
(mg/dL tai mmol/L)

Verensokeriarvo (mg/dl tai mmol/l), jota 
käytettiin sensorin kalibrointiin.

Sensor Glucose (mg/dL tai 
mmol/L) Sensorin glukoosiarvo.

ISIG value Tulosignaalit (ISIG), jotka luetaan sensorista ja 
mitataan nanoampeereina (nA).

Sarakkeen otsikko Kuvaus
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Sa
na

st
o

Sanasto

A
A1c   Glykosyloitunut hemoglobiini.

A1c-testi  Hemoglobiinin A1c-testi, jolla arvioidaan pitkäaikaista 
verensokeripitoisuutta.

Askel  Käyttäjän määrittämä insuliinimäärä, jota käytetään helpon 
lisäannoksen annostelussa.

Aterialisäannos  Insuliiniannos, joka kattaa aterian jälkeen 
odotettavasti nousevan verensokerin.

AUC (area under the curve), keskimääräinen  Keskimääräinen 
hyperglykemia- tai hypoglykemia-altistus ajanjaksona, jolloin sensori 
lähetti tietoja.

C
CareLink™-USB-laite  Laite, jonka avulla Medtronic Diabetes 
Paradigm -sarjan insuliinipumppuun tai Guardian REAL-Time 
-monitoriin tallennetut tiedot voidaan ladata CareLink™ -ohjelmistoon 
käyttämällä tietokoneen USB-porttia.

CareLink™ Personal  Online-palvelu, joka mahdollistaa diabeteksen 
hallinnan Internetin kautta.

ComLink   Radiotaajuinen (RF) lähetin-vastaanotinlaite, jolla 
ladataan Paradigm-pumpun tai Guardian REAL-Time CGM -järjestelmän 
tiedot tietokoneeseen.

Com-Station  Laite, jolla ladataan MiniMed 508 -pumpun ja 
kolmansien osapuolien mittareiden tiedot tietokoneeseen.

D
Dual Wave® -lisäannos  Yhdistelmälisäannos, joka koostuu 
välittömästi annosteltavasta normaalista lisäannoksesta ja sen perään 
annosteltavasta jatketusta lisäannoksesta (Square Wave -lisäannok-
sesta). Jatketun lisäannoksen osuus annostellaan tasaisesti tietyn 
ajanjakson kuluessa.
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E
Easy Bolus™  Helppo lisäannos, normaalin lisäannoksen annostelu-
tapa. Helppo lisäannos annostellaan pumpun helppo lisäannos 
-painikkeella.

H
HbA1c   Glykosyloitunut hemoglobiini.

HbA1c-testi  Hemoglobiinin A1c-testi, jolla arvioidaan verensokeripi-
toisuuden hallintaa tai keskiarvoa 2–3 kuukauden ajanjaksolta.

HH  Hiilihydraatti.

Hiilihydraattisuhdeluku  Grammoina ilmoitettu hiilihydraattimäärä, 
jonka yksi insuliiniyksikkö kattaa. (Katso myös ”Vaihtoannossuhde-
luku”.)

Hiilihydraattiyksiköt  Bolus Wizard -toiminnon käytössä tarvittava 
ateriatieto. Yksiköksi valitaan hiilihydraattigrammat tai -vaihto-
annokset.

Hyperglykemia  Verensokeriarvojen tarkkailulla havaittu korkea 
verensokeri, jolla voi olla joitakin seuraavista oireista: pahoinvointi, 
oksentelu, näön hämärtyminen, päänsärky, vatsavaivat, lisääntynyt 
virtsaamistarve ja virtsan määrä sekä letargia. 

Hypoglykemia  Verensokeriarvojen tarkkailulla havaittu matala 
verensokeri, jolla voi olla joitakin seuraavista oireista: kova nälkä, 
tärinä tai vapina, hikoilu, kaksoiskuvat, huimaus, päänsärky, 
sammaltava puhe, äkilliset mielialanvaihtelut tai persoonallisuuden 
muutokset.

I
Infuusiosetti  Infuusiovälineet, joilla asetetaan ja kiinnitetään 
kanyyli ihon alle ja jotka kuljettavat insuliinin asetuskohtaan 
pumpusta letkun kautta.

Insuliiniherkkyys  Määrä (mg/dl tai mmol/l), jonka yksi 
insuliiniyksikkö laskee verensokeria (VS). (Tämä on Bolus Wizard 
-toimintoon ohjelmoitu tieto.)

Insuliinipitoisuus  Insuliinin voimakkuus tai tyyppi, jonka lääkäri on 
määrännyt käyttäjälle. Se vaikuttaa pumpun insuliinin annosteluno-
peuteen. Jos käyttäjän insuliinipitoisuus muuttuu, perusannosmallit, 
maksimiperusannos ja lisäannokset on ohjelmoitava pumppuun 
uudelleen.

J
Jatketun lisäannoksen osuus  Yhdistelmälisäannoksen (Dual Wave 
-lisäannoksen) toinen osa (Jatk., Jtk). Jatketun lisäannoksen osuus 
annostellaan tasaisesti tietyn ajanjakson kuluessa normaalin osuuden 
(Nyt) jälkeen.
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K
Kalibrointimuistutus   Käyttäjän valitsema kalibrointimuistutuksen 
arvo on aika, jonka kuluttua senhetkinen kalibrointiarvo vanhenee ja 
pumppu antaa MITT. VS VIIM -varoituksen. Jos kalibrointimuistutuksen 
ajaksi on asetettu esimerkiksi kaksi tuntia, monitori antaa MITT. VS 
VIIM. -varoituksen kaksi tuntia ennen vaadittua kalibrointiajankohtaa.

Ketonitesti  Ketoni on kuona-aine, jota elimistö tuottaa, kun sen on 
poltettava rasvaa glukoosin sijasta tuottaakseen energiaa. Se voi olla 
merkki elimistön insuliininpuutoksesta. Ketonitestillä mitataan veren 
tai virtsan ketonipitoisuutta.

Korjauslisäannoskerroin (herkkyyskerroin)  Arvo, joka osoittaa, 
kuinka paljon 1,0 yksikköä insuliinia laskee verensokeria. Kertoimen 
avulla lasketaan korjauslisäannoksen määrä, kun verensokeri on 
korkea.
(verensokeriarvo) – (verensokerin tavoitearvo) = X 
X ÷ (korjauslisäannoskerroin) = 
korjauslisäannoksen määrä

Korjauslisäannos  Tarvittava insuliinimäärä, jolla lasketaan korkea 
verensokeri tavoitealueelle.

Korkea glukoosi  Pumppu hälyttää, jos sensori osoittaa, että 
käyttäjän verensokeri on yhtä suuri tai suurempi kuin tämä arvo. Voit 
ottaa tämän toiminnon käyttöön tai poistaa sen käytöstä.

L
Lataaminen  Pumpun tai mittarin tietojen siirtäminen 
CareLink™ Personal -palvelimeen.

Linkittää, linkki  Linkittäminen tarkoittaa mittaritoiminnon käyt-
töönottoa ja asetusten määrittämistä, jotta pumppu voi vastaanottaa 
verensokeriarvot CONTOUR® LINK-, OneTouch® UltraLink™- tai 
Paradigm Link® -mittarista.

Järjestelmässä linkki tarkoittaa myös hypertekstilinkkiä. Kun 
napsautat hypertekstilinkkiä, se siirtää sinut toiseen kohtaan 
järjestelmässä tai toiseen www-sivustoon.

Lisäannoksen äänimerkki  Pumppu voidaan ohjelmoida antamaan 
äänimerkki, kun käyttäjä valitsee annosteltavan lisäinsuliinin määrän 
(0,5 tai 1,0 yksikköä). Tämä on hyödyllistä tilanteissa, kun pumpun 
painikkeita on vaikea nähdä.

Lisäinsuliini  Insuliiniannos, jonka tarkoitus on kattaa verensokerin 
odotettavissa oleva nousu (esimerkiksi aterian tai välipalan jälkeen) 
tai laskea korkea verensokeri tavoitealueelle.

Lähett. SN   Käytössä olevan lähettimen sarjanumero.

M
Maksimilisäannos  Lisäinsuliinin enimmäismäärä, joka pumppu voi 
annostella kerralla. (Käyttäjä määrittää asetuksen.)
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Maksimiperusannos  Perusinsuliinin enimmäismäärä, joka pumppu voi 
annostella kerralla. (Käyttäjä määrittää asetuksen.)

Malli A/B  Perusannosmalli, joka sopii tavallisesta päivärutiinista 
poikkeaviin mutta kuitenkin normaaliin elämäntapaasi kuuluviin 
toimiin. Tällaisia toimia voivat olla esimerkiksi viikoittainen 
urheiluharrastus, unirytmin muutos viikonloppuisin, pitkät voimak-
kaan tai vähäisen aktiivisuuden jaksot tai kuukautiset.

Manuaalinen lisäannos  LISÄANNOSVALIKOSSA valittavissa oleva 
vaihtoehto, kun Bolus Wizard on käytössä. Yksi tapa ohjelmoida 
lisäannos ilman Bolus Wizard -toimintoa. 

Matala glukoosi  Pumppu hälyttää, jos sensori osoittaa, että 
käyttäjän verensokeri on yhtä suuri tai pienempi kuin tämä arvo. Voit 
ottaa tämän toiminnon käyttöön tai poistaa sen käytöstä.

Mittari  Lääkinnällinen laite, jolla määritetään veressä olevan 
glukoosin likimääräinen pitoisuus. Pieni tippa verta asetetaan 
kertakäyttöiselle testiliuskalle, jonka mittari lukee ja jota se käyttää 
verensokeriarvon laskennassa. Mittari näyttää verensokeriarvon milli-
grammoina desilitrassa tai millimooleina litrassa (mg/dl tai mmol/l). 

Mittaritoiminto  Toiminto, jonka avulla pumppu voi vastaanottaa 
verensokeriarvot linkitetystä verensokerimittarista.

l  Mikrolitra.  

N
Normaali lisäannos  Määritetyn insuliiniyksikkömäärän välitön 
annostelu. 

Normaali malli  Normaali perusannos, joka sopii potilaan tavallisiin 
päivittäisiin rutiinitoimiin. Kun mallitoiminto on poissa käytöstä, 
pumppu käyttää normaalia perusannosmallia.

P
Perusannosmallit  Potilas voi ohjelmoida enintään kolme perusannos-
mallia, joiden mukaan pumppu annostelee perusinsuliinia: normaali, 
A ja B. Kuhunkin perusannosmalliin voidaan määrittää enintään 
48 perusannosta.

Perusannosprofiili  Perusannos, jolla on aloitus- ja lopetusaika. 
Käyttäjä voi ohjelmoida pumppuun 24 tunnin ajanjaksolle useita 
erilaisia profiileja, joilla on kullakin erilainen perusannos.

Perusannos  Pumpun asetus, joka annostelee insuliinia jatkuvasti ja 
pitää verensokeripitoisuuden vakaana aterioiden välissä ja yön 
aikana. Perusinsuliini jäljittelee haiman insuliinieritystä ja kattaa 
siten elimistön kaiken aterioista riippumattoman perusinsuliini-
tarpeen.
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Perusinsuliini  Insuliinipumpun automaattisesti ja jatkuvasti 
annostelema tuntikohtainen insuliinimäärä, joka määräytyy 
pumppuun esiohjelmoitujen profiilien ja yksilöllisten annosteluno-
peuksien mukaan. Pumppu annostelee insuliinia vuorokaudessa 
määrän, joka tavallisesti kattaa potilaan tarvitseman perusinsuliinin 
paaston aikana (eli yön aikana ja aterioiden välissä).

Pikalisäannos  Minkä tahansa lisäannostyypin annostelutapa. 
Pikalisäannos annostellaan pumpun pikalisäannospainikkeella.

Pysäytys  Pumpun toiminto, joka pysäyttää kaiken insuliinin 
annostelun. Kaikkien senhetkisten lisäannosten ja/tai täyttöinsuliinin 
annostelu peruutetaan. Perusannoksen annostelu keskeytyy, kunnes 
pumppu käynnistetään uudelleen. 

R
RF  Radiotaajuus, radiotaajuinen. 

S
Square Wave® -lisäannos  Lisäannos, jonka pumppu annostelee 
tasaisesti käyttäjän määrittämän ajan kuluessa (ajaksi voidaan 
määrittää 30 minuuttia–8 tuntia). 

V
Vaihtoannossuhdeluku  Arvo, joka ilmoittaa, kuinka paljon insuliinia 
tarvitaan yhden (1) hiilihydraattivaihtoannoksen kattamiseen. (Katso 
myös ”Hiilihydraattisuhdeluku”.)

Vajaa säiliö -varoitus  Ohjelmoitava varoitus, joka varoittaa pumpun 
käyttäjää, kun säiliössä on jäljellä määritetty yksikkömäärä tai kun 
säiliö tyhjenee määritetyn ajan kuluessa.

VS  Verensokeri.

Väliaik.  Väliaikainen.

Väliaikainen perusannos  Väliaikainen kertaluonteinen perusannos, 
jolle määritetään määrä ja kesto. Väliaikaisella perusannoksella 
voidaan kattaa erityisten normaalista päivärutiinista poikkeavien 
toimien tai tilojen aiheuttama insuliinintarve.
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